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Mail Factory License Agreement
THIS LICENSING AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU, EITHER AN
INDIVIDUAL OR A SINGLE ENTITY, AND BELIGHT SOFTWARE ("LICENSOR"). IF YOU DO NOT AGREE TO EACH
AND EVERY TERM, YOU SHOULD NOT OPEN, USE OR INSTALL THE SOFTWARE. YOU MUST EITHER RETURN
THE SOFTWARE, DOCUMENTATION AND PACKAGING TO THE PLACE OF PURCHASE OR, IN THE CASE OF
DOWNLOADED SOFTWARE, DELETE THE SOFTWARE FROM YOUR COMPUTER AND/OR ANY OTHER DATA
STORAGE DEVICE.

1. GENERAL
The software, documentation and any images or ready-made designs accompanying this License whether on disk, on any other
media (collectively the "Software") are licensed to you by BeLight Software ("Lisensor") for use only under the terms of this
License, and Licensor reserves all rights not expressly granted to you.   The rights granted herein do not include any other patents
or intellectual property rights.
Title and intellectual property rights in and to any content displayed by or accessed through the Software belong to the respective
content owner. This License does not grant you any rights to use such content.

2. LICENSE
Licensor hereby grants to You, and You accept, a non-exclusive license to install and use Software and Documentation, only as
authorized in this license. The license permits either multiple users to install and use the software on a single computer, or a
single user to install and use the software on multiple computers. The license doesn't allow multiple users to use the Software on
multiple computers. You agree that You will not assign, sub license, transfer, pledge, lease, rent, or share Your rights under this
license. You may not reverse engineer, decompile or disassemble the Licensed Software for any purpose whatsoever.
Clip Art and Photo Images: The Software contains numerous images (hereafter as “Images”) that are either owned by Licensor or
licensed from a third party. You are free to use, modify and publish the Images as you wish subject to the restrictions set out in
this section. If you are uncertain about your rights to use any material, you should contact your legal advisor.
You may NOT resell, sublicense or otherwise make available the Image(s) for use or distribution separately or detached from the
product.  You may NOT a) create scandalous, obscene, defamatory or immoral works using the Image(s) nor use the Image(s) for
any other purpose which is prohibited by law; b) use or permit the use of the Image(s) or any part thereof as a trademark or
service mark, or claim any proprietary rights of any sort in the Image(s) or any part thereof; c) use the Image(s) in electronic
format, on-line or in multimedia applications unless the Image(s) are incorporated for viewing purposes only and no permission
is given to download and/or save the Image(s) for any reason; d) use any Image(s) except as expressly permitted by this License;
and e) use the Image(s) related to identifiable individuals, products or entities for any commercial purpose or in a manner which
suggests their association with or endorsement of any product or service.

3. TRANSFER
You may not distribute copies of the Software including clip art images, photo images, ready-made designs, in whole or in part,
to any third party, nor may you use, rent, loan, sublicense, or lease the Software to third parties.  You may, however, transfer all
your rights to use the Software to another person or legal entity provided that: (a) You also transfer this Agreement, the Software
and all other software bundled or pre-installed with the Software, including all copies, Updates and prior versions, to such person
or entity;  (b) You retain no copies, including backups and copies stored on a computer; and (c) the receiving party accepts the
terms and conditions of this Agreement and any other terms and conditions upon which You legally purchased a license to the
Software. Notwithstanding the foregoing, You may not transfer pre-release or not for resale copies of the Software.

4. ILLEGAL USE
You are not to use the Software, whether directly or indirectly, for any illegal purpose under the laws or ordinances of Federal,
State, or local governments.  It is Your sole responsibility to know and understand the laws and/or ordinances that govern the use
of the Software.  In the event that You violate any Federal, State or local law or ordinance by direct or indirect use of the
Software, You shall take full legal responsibility for such illegal use.  You shall hold Licensor harmless and without fault and
otherwise indemnify Licensor for any damage, cost or liability incurred by Licensor as a result of any use, whether or not such
use is within the scope of the license set forth herein.

5. UPDATES
If the Software is an Update to a previous version of the Software, You must possess a valid license to such previous version in
order to use the Update.  You may continue to use the previous version of the Software on your computer after You receive the
Update to assist You in the transition to the Update, provided that: the Update and the previous version are installed on the same
computer; the previous version or copies thereof are not transferred to another party or computer unless all copies of the Update
are also transferred to such party or computer; and You acknowledge that any obligation BeLight Software may have to support
the previous version of the Software may be ended upon availability of the Update.

6. LICENSOR'S RIGHTS
You acknowledge and agree that the Software and Documentation consists of proprietary, published and unpublished property of
Licensor. You further acknowledge and agree that all right, title, and interest in and to the Software and Documentation are and
shall remain with Licensor. This license conveys to You the right to install and use the Software and Documentation in
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accordance with the terms of this license. All rights not expressly granted here are reserved by BeLight Software. The Licensor
will not transmit your personal information to any third party without your express consent.

7. TERMINATION
This license is effective upon Your installing the software on any machine, and shall continue until terminated. You may
terminate this Agreement at any time.  The Licensor may immediately terminate this License Agreement if you breach any
representation, warranty, agreement or obligation contained or referred to in this License Agreement.  Upon termination, you
must dispose of the Software and all copies or versions of the Software by destroying the Software.

8. LIMITED WARRANTY
BeLight Software provides a thirty (30) day money-back guarantee on the Software. If, during this period, you are dissatisfied
with the Software for any reason, BeLight Software will refund your money if you return the Software and all copies to the place
of purchase within thirty (30) days of the date of the original purchase.  THE FOREGOING IS THE SOLE AND EXCLUSIVE
WARRANTY OFFERED BY BELIGHT SOFTWARE. BELIGHT SOFTWARE DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE LICENSED SOFTWARE AND ALL
ACCOMPANYING MATERIALS. BELIGHT SOFTWARE AND ITS AGENTS DO NOT AND CANNOT WARRANT THE
PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE.

9. LIMITATION OF LIABILITY
IN NO EVENT WILL BELIGHT SOFTWARE OR ITS AGENTS BE LIABLE TO YOU FOR ANY DAMAGES, CLAIMS OR
COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES, OR ANY LOST PROFITS
OR LOST SAVINGS.   BELIGHT SOFTWARE'S AGGREGATE LIABILITY AND THAT OF ITS AGENTS UNDER OR IN
CONNECTION WITH THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT PAID FOR THE SOFTWARE, IF
ANY.

10. FEES
The Software is available in download version. If your download version of the Software does not come with a License Code,
you may register your copy of the Software by purchasing a License Code for the download version at:
http://www.belightsoft.com/composer/buy/  The License Code will disable the restricted printing feature of the Software.
You may not distribute the License Code.  By clicking "Agree", you acknowledge that you have paid the Licensor all applicable
license fees for the Software.

11. SEVERABILITY
Should any term of this license be declared void or unenforceable by any court of competent jurisdiction, such declaration shall
have no effect on the remaining terms hereof.

12. GENERAL PROVISIONS
This License Agreement is personal between You and BeLight Software. It is not transferable and any attempt by You to rent,
lease, sublicense, assign or transfer any of the rights, duties or obligations hereunder. YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE
AGREEMENT BETWEEN YOU AND BELIGHT SOFTWARE WHICH SUPERSEDES ANY PROPOSAL OR PRIOR
AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND BELIGHT
SOFTWARE OR BELIGHT SOFTWARE'S AGENT(S) RELATING TO THE LICENSED SOFTWARE.

If you have any questions regarding this Agreement or if you wish to request any information from BeLight Software please use
the address and contact information included with this product to contact BeLight Software.
© 2003-2006 BeLight Software, Ltd. All Rights Reserved. BeLight Software and Mail Factory are trademarks of BeLight
Software, Ltd. Mac, the Mac logo, Mac OS X, iPhoto, and Macintosh are trademarks of Apple Computer, Inc. Digital image
content. All rights reserved. Avery is the trademark of of Avery Dennison Corporation. All other trademarks, registered
trademarks, product and/or brand names are the sole property of their respective owners.
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Chapter 1
Introduction

Welcome to Mail Factory

Thank you for choosing Mail Factory, the fastest way to print envelopes, labels and postcards on your
Macintosh. Whether you want to print just one address, or prepare a mass mailing - Mail Factory will best fit
these needs.

Mail Factory supports numerous envelope sizes and large number of mailing labels from Avery, APLI, A-One
and other manufacturers.

Mail Factory prints on DYMO (LabelWriter-series), Seiko (SLP-series) and Brother (QL-series) label printers
and almost all decktop printers.

Mail Factory integrates with Mac OS X Address Book, Microsoft Entourage, Microsoft Excel, Now Contact and
File Maker Pro, allowing you to mix contacts from different sources into one mailing list. The program
features a lot of ready-made label and envelope designs and various effects for images, including masks,
opacity control, shadow effects. Intuitive and elegant interface makes creating labels and envelopes fast and
easy.

System Requirements

• Mac OS X v10.2 or later
• 50 MB of available disk space
• Printer - inkjet or laser (optional)

Installing and Removing Mail Factory

To install Mail Factory:
• Double-click the *.dmg file.
• Double-click the Mail Factory installer icon in window that appeared.
• Follow the installer instructions.

If you wish to remove the program from your computer please complete the following steps:
• Quit Mail Factory application if it is running.
• Delete Mail Factory from Application folder.
• Delete Mail Factory folder from /Library/Application Support/BeLight Software
• Delete com.belightsoft.mailfactory.plist file from ~(User Home)/Library/Preferences/.
• Delete Mail Factory folder and com.belightsoft.mailfactory folder from

 ~(User Home)/Library/Caches/.
• Delete "Mail Factory.pkg" file from (Your Macintosh HD)/Library/Receipts/ folder.

Registration

To register Mail Factory, enter your License Code in the License dialog that comes up when you launch the
software, or in the System menu choose Mail Factory/License...

If you already purchased Mail Factory from BeLight Software or its resellers, you'll find the License Code in
the purchase confirmation e-mail or inside the Mail Factory pack (in case of the CD version).
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To enter your license code (if it is in e-mail), copy it from an e-mail that informed you about successful
purchase, then launch Mail Factory and choose "License..." from the application menu; then paste the code
into the dialog box that comes up. It’s recommended to save this mail for the case you will need to register
the application after re-installation or after update.

In case of the CD version, enter code manually. Be attentive, don't use 'O' character, type only 0 (zero) digit
in the license code. There is also no small letter 'I', but only 1 (one) digit in the license code.

The unregistered version of Mail Factory is fully operational. The only limitation is that it prints "Mail Factory
Trial Version" text at the bottom of each label or envelope that you print. To eliminate this text, you need to
register your copy of the software.

To move from the trial to the registered version of the program you need to purchase and register it. See
details on our web site:
http://www.belightsoft.com/buy/

Difference between Mail Factory and Mail Factory Home Edition

The application exists in two main versions: Mail Factory and Mail Factory Home Edition.

Feature Mail Factory Mail Factory Home Edition
Supported address data
sources:

• Apple Address Book √ √
• vCard √ √
• Microsoft Entourage √ −
• Microsoft Excel √ −
• Now Contact √ −
• File Maker Pro √ −
• Text file √ √

Internal database for storing
and editing addresses for
Merge Printing

√ −

Merge Printing – prints different
addresses on a single label
sheet or on envelopes or
postcards from a batch

√ −
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Useful Web Resources

Mail Factory page:
http://www.belightsoft.com/mailfactory
Information about Mail Factory, links to Download, Latest Update, Buy and FAQ sections.

Postal Resources in the Internet:
http://www.belightsoft.com/products/resources/postal.php

BeLight Software Web site:
http://www.belightsoft.com
Check it out for updates, new product announcements, special offers.

Buy Mail Factory:
http://www.belightsoft.com/buy
Here you can purchase Mail Factory.

BeLight Software Technical Support:
http://www.belightsoft.com/support
See this link for technical support.
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Chapter 2
Answers to Simple Usage Questions

I have an address. How to print it on an envelope?

Here is a sequence of operations to print addresses on an envelope using Mail Factory. Let's suppose you are
going to print one envelope (and without frills). To do this you need to prepare two things: envelope
document and contact data (delivery and return addresses).

Mail Factory gives you enough tools to design an envelope from scratch, but it is easier to use Assistant. This
tool will help you with design and contact data.

So, start your new document from Assistant. The first two steps will help you to select an envelope size and
how your envelope will look like.

At the third step you can enter recipient's and sender's addresses. Sender's address can be taken from Apple
Address Book, pasted from Clipboard entirely or typed (or copied field by field) into corresponding data
fields. The “Paste From Clipboard” command will help you with placing data from Clipboard into address
fields of Mail Factory.
There are the same possibilities for a Recipient address but additionally you can access all supported
databases through import.
You will be able to enter or correct both addresses later at any time.

After you have finished working with Assistant, you can copy a text block with address and paste it via
Clipboard directly into address panel in your document. For this, press Cmd+Opt+V or choose “Paste As
Address” in the Edit menu. The address will be distributed in address fields.
Or you can paste it in your document as a text block (Cmd+V).

When your envelope is ready, you can move to printing. In the Print window you can change a printer (if you
have several), paper feed and printing rules. The most important is to set the correct number of copies and
paper feed (the way envelope will be inserted into the printer). Envelopes are usually inserted in the center of
Laser printer tray and at one side of InkJet printer tray. Some printers have a special tray for envelopes. If
you use such a tray, you need to set “Load from envelope tray”.

What is batch printing?

For instance, you need to send a number of envelopes with different delivery addresses. Normally this would
mean you have to change a recipient address before printing each next envelope.

Batch printing (Merge Printing) is a way to print different delivery addresses in one print task. They will be
automatically taken from a print list.

You will need to design an envelope (or label) and compose a list of recipients (print list). The program will
automatically take another recipient address from your list when print each next envelope or label.

For more information about Merge Printing see Chapter 9.
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How to create a print list?

Mail Factory has an embedded Print List database. Once created, a print list will be accessible until you
remove it. It’s possible to save several print lists.

When you create a new print list it is empty. There are several ways to fill it with contact data. The first is to
import data from other databases like Address Book, Excel, Entourage and other. Imported data is saved in
the program cache. So you don’t need to import again after restarting Mail Factory, the data will be shown
from the cache. You can update cached data if your external database was changed.

Another way to create a print list is to add a blank person’s records and fill them with data. Mail Factory
allows modifying fields with personal data.

For more information about print lists see Chapter 10.

Where I can take addresses from to use in Mail Factory

Addresses can be stored in different locations on your computer.
• There are special programs for working with contact information like Apple Address Book, MS Entourage
and other.
• Addresses can be organized using a common purpose database like FileMaker Pro.
• Addresses can be stored in a text file with delimiters (data fields are separated there by Tabs or commas).
Usually such tab- or comma-delimited files are the result of export from some databases or contact
managers and aren’t handy.

Alternatively, you can take address from e-mail or some text file like one- or multiple-line text block. In such
case you will copy a block of text with address into Clipboard and then paste it in Mail Factory.
Also, you can keep contact data in one of embedded databases of Mail Factory.

Using contact data from different sources
Table 2.1

Data source How to access data from Mail Factory
Apple Address Book Automatic import every time you start Mail Factory.

Contact data is always up to date.
Contact managers and databases:
Now Contact
MS Entourage

Start import manually via the Contacts window. (1) (2)
(5)

Microsoft Excel Start import manually via the Contacts window. (1) (3)
(5)

vCard Start import manually via the Contacts window.
Tab- or comma-delimited text file Start import manually via the Contacts window. (3)
Text block 1). Paste data from the Clipboard using “Paste As

Address” option.
2). Paste address directly into a text box. (4)

(1) Databases and contact managers can often export data to tab- or comma-delimited text files. If you
encounter difficulties with import from an application directly or if Mail Factory doesn’t support import from
your database, import data via tab-delimited text file.

(2) Contact managers usually can save contact data as a vCard file. It also can be used as an alternative
import method. Some of contact managers save only one person's data per vCard file.

(3) Databases and text files exported from databases usually have header that helps Mail Factory correctly
interpret the meaning of data fields. When such data source doesn’t have a header, you need to associate
importing data with Mail Factory internal data fields in the “Map To” dialog during the import process.

(4) If an address was pasted in a text box (not in an address panel), the program will recognize it as text. In
this case functionality like automatic address formatting, bar codes, batch printing will be unavailable.
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(5) You need to have the coresponding application installed on your computer to import its data.

If an address is written on a piece of paper, you can type it in fields of an address panel or into embedded
database (it’s better because data will be saved for further use).

Mail Factory stores all imported addresses in the internal cache, so that you don’t need to import every time
you start Mail Factory.

Example. How to deal with DayLite program (direct import from which is not supported).
According to DayLite specification, it can:
• Export contacts to vCard
• Save any list view as tab-delimited data
• Synchronize with Apple Address Book

Mail Factory can import from Apple Address Book, vCard and from tab- and comma-delimited text files.
So there are several possibilities to import data from DayLite.

It is better to use vCard or tab-delimited text file in our case. See details in Appendix D.
Transfering data via Address Book is not a good idea unless you are going to keep data from DayLite there.

How addresses differ?

Addresses have different formats.

1. Different countries have their own address standards:
- in what sequence address must be written;
- width of spaces between letters, words and lines; width of border margins; bar code dimensions; where
delivery and return addresses must be placed on an envelope (all this is significant for automatic address
recognition).

2. Address can contain different information. Correspondence can be addressed to a person or to a
company. Address can be written more officially (for business purposes) or less officially (to a private
person).

Mail Factory considers these factors having country-specified address formats and address templates with
different sets of address fields.

See more about address panels and address fields in the Chapter 8.

Apple Address Book has Phone, Fax and Email fields.
How to use them in Mail Factory?

Standard address panels in Mail Factory contain the most common postal information. Fields for telephone
or fax number aren’t included. But Mail Factory can deal with them and with various of other fields.

To see all available data fields, you need to open the Address Fields tab of the Design window. You can drag
them on your label (you'll get separate field). By default, such field shows data of a person, selected in the
Contacts window. You can choose another sender's data to display in this field using the Inspector window.

You can drag several data fields from the Design window and group them into an address panel.

To add a data field to an existing address panel, you need to ungroup this address panel, place a new field
among others and group all these fields again.

Address book can contain several telephone numbers (work, home). Mail Factory allows you to select one of
them (“Preferred Address”) in the Inspector window.

For more information about address fields see Chapter 8, "Working with Text Fields” and “Working with
Address Panels”.
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Several sender addresses

Mail Factory allows you to switch among several return addresses.
This can be used when several people use the program or when one person uses work and home addresses.

The program takes return addresses from the Sender list, that can contain as many sender's records as you
need.

For more information about the Sender list see Chapter 10, “Sender Database”.

How to avoid printing the country name

In some countries (like USA) it is common not to indicate country name when correspondence must be
delivered within this country.

Country name printing can be switched off in the Print window of Mail Factory and in program preferences
(default value).

For more information about Printing see Chapter 9.

What to do if I didn’t find my paper in the program list?

When you create a document using Assistant, first its window shows a list of all supported envelopes and
label papers. The same list can be open by the Layouts toolbar button. Selected there paper layout will be
used in your document.

If you have paper that is not listed, it is still possible to print on it.

1. Manufacturers produce variety of label paper that has the same size but differs in characteristics like:
- plain paper / glossy paper / weatherproof paper / photo quality paper …
- paper for laser or inkjet printers
- paper with different colors.
If you can’t find exactly the same paper, find paper with the same label size. Gap width between labels,
margins and other dimension also must be the same.

2. Mail Factory allows you to create a custom envelope or label paper template. You can measure your label
paper or envelope and enter dimensions into the program (see about custom layouts).

Exporting your document

To use your label or envelope document later you save it. Mail Factory saves documents in its own file
format. Other programs can’t open Mail Factory documents.

If somebody wants to see your document on another computer (where Mail Factory isn’t installed), you have
to send him your label or envelope document in such file format that can be opened everywhere.

Mail Factory can export documents to PDF and TIFF file formats (usually used for documents and pictures).
Your PDF or TIFF document can be viewed (like in Preview before printing). But editing text and images as
Mail Factory objects will be impossible. PDF and TIFF file formats don’t provide this.

Export is useful if you are going to send your documents to a printing company.
If your document is intended to be printed in a printing company, refer to their requirements.

To export a document, select File/Export menu (or press Cmd+Opt+E). Then select output file name, folder,
where to save, and file format.
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Printing on label printers

Using label printers (like Dymo LabelWriter) has some differences from ordinary desktop printers.

A label printer uses special label paper (on ribbons) not Letter or A4 sized sheets. The maximal height of a
label is limited by printer size and is usually several inches.

Labels on a ribbon go one after another. This is why label printers can print only one label per time. Printing
on ordinary printers, you insert a sheet 20-50 labels paper into them even if you need to print only one label.
Label printer doesn’t waste paper. It prints the exact number of labels you need.

For more information about label printers see
“Using a DYMO Printer to Print Labels”:
http://www.belightsoft.com/products/companion/printers/dymo.php

Technology Used in Label Printers. Brief description of Seiko, Brother and Dymo label printers.
http://www.belightsoft.com/products/companion/printers/labelprinters.php
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Chapter 3
Program Interface

The Main Window

The main application window is comprised of two parts - the design canvas and the toolbar. The design
canvas is the area where you will design and edit your envelopes and mailing labels, add or modify
addresses.
It displays the outlines of a label or an envelope - depending on the document type.

The tool switch on the toolbar has two conditions:
Select tool for working with objects (select, drag, etc.) and Text Edit tool to place a new text box or to edit
the existing text.

Address Panel button is a tool for adding address panels. For more details about address panels see
Chapter 8.
On the right side Zoom control is located. To change the scale use slider or “-” and ”+” buttons.

The toolbar contains Design, Inspector, Contacts and Layout buttons for opening and closing corresponding
windows.

Merge Printing button launches mass mailing mode. In this mode addresses for labels or envelopes will be
automatically taken from a list.
Print button starts ordinary printing. One or several labels or envelopes will be printed with the same
address.
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The Design Window

The Design window is the main source of objects in the program. The following
objects can be added to the document using the Design window: Address Panels,
Text Fields, Text, Images, Smart Shapes.

All objects in the Design window are grouped in four tabs: Address templates,
Address fields, Image collection and Handling Labels.

Open the Design window
Menu: Window/Show Design
Shortcut: Cmd+Shift+D

Address templates tab contains the list of address panel templates. These
templates differ in purpose, in combination of fields and fields' positioning. You can
drag and drop a template on the envelope or label. You will get "To" address panel
and if you have already selected the recipient, his personal data will be
automatically inserted there. An address panel can be switched to "From" (to display
the sender's address) using Format/Refers To command from the menu. The
template of the selected address panel can be also changed later. Choose the
Format/Address Template menu to do this.
For more details about address panels see Chapter 8.

Address fields tab contains the list of separate text fields (name and other personal information). You can
drag and drop a field on the envelope or label. If you have already selected a person, his corresponding
personal data will be inserted automatically into this field.
Later address fields can be grouped into address panels.

Image collection gives access to several image collections: Clipart, Smart Shapes,
iPhoto, Custom Folder.

• Clipart is a large amount of pictures supplied with the program. Use "Clipart"
pop-up menu to select image category, then scroll up or down to find a
picture within the category. Another way to find a picture is to search by
name. You can search within the clipart or in the Internet. To select search
area click the "lens" button in the edit box. For more details about images see
Chapter 8.

• Smart Shapes is a collection of vector geometrical shapes with controllable
behavior. For more details about Smart Shapes see Chapter 8.

• iPhoto shows pictures from the Apple iPhoto.
• Custom Folder shows images from any folder selected by you. Click Browse

button and select a folder with your images. Images from this folder will be
displayed in the collection window.
Custom Folder is a suitable embedded image browser. You do not need to
switch to other applications for previewing images from your hard disk.
Select a folder and you will see thumbnails of images from this folder in the
Design window. You can start working with the images immediately.

Handling labels - various handling signs such as "Air Mail", "FRAGILE" and other,
supplied with the program. Use "Labels" pop-up menu to select the label category.

Note: if you have selected an object on your label or envelope and then clicked on
another object of the same type in the Design window, the selected object will be replaced
with the new one. Thus, you can replace one image with another one, replace a smart shape with a new smart shape
and change address panel type. Object's size will be preserved. If you have selected several images, all of them will
be replaced.
But if a smart shape is selected, clicking on image will result in adding a new image, because these objects are of
different types. Images from Image Collection, Handling Labels, iPhoto library and Custom Folder belong to one
type.
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The Inspector Window

The Inspector window is the main set of tools for editing objects and setting their
properties in Mail Factory. Objects can be of different types: Address Panels, Text
Fields, Barcodes, Text, Images, Smart Shapes. The Inspector affects the way they
look.

The set of tools in the Inspector depends on the object that is selected. Every object
has its own attributes that can be adjusted.

The use of the Inspector is described in "Working with Objects" section, Chapter 8.

Open the Inspector window
Menu: Window/Show Inspector
Shortcut: Cmd+Shift+I
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The Contacts Window

Mail Factory can get addresses and other personal information from different
sources. You can access them via the Contacts window. When you choose a
person from the list in Contacts, his details are automatically displayed in the
Address Panels and Text Fields available in the document. "From" tab opens
access to the internal sender database. "To" and "Print List" tabs manage the
recipient's details.

"From" tab (Sender List)

This is the list of return addresses. To edit the list, click Edit List button. Sender
database will come up. Here you can add new records or modify existing ones. For
more details about Sender database see Chapter 10.

"To" tab (Recipient List)

The Recipient list consists of personal data that was taken from one of external sources (see Chapter 11:
Integration with Third-Party Databases and Contact Managers) or the embedded My Recipients database
(see Chapter 10: Embedded Databases).
The external databases can be: Apple Address Book (used by default), MS Entourage, Eudora, Now Contact,
vCard file, Text File, MS Excel, FileMaker Pro. To find a name within the current list, type the name in the
search field below.
If such address source as “Text File” is selected, this file can be reloaded by clicking Update button. This is
useful when you need to edit data in the text file without closing Contacts window or if you want to switch to
another text file.

"Print List" tab

Print List is a list of recipients - a useful feature for batch printing multiple labels and envelopes. For more
details about Print List see Chapter 10.

Note: You can edit the personal information right in the Contacts window by double-clicking on the person's name
(the exception is the data from external applications, such as Apple Address Book, etc.).

Open the Contacts window
Menu: Window/Contacts/Show
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The Layouts Dialog

The Layouts dialog allows you to choose label paper
or an envelope, or to create a custom-sized label or
envelope template. Also, you can appoint one from
recently used paper types. For more details about
paper layouts see Chapter 5.

Open the Layouts window
Menu: Format/Change Layout
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Chapter 4
Assistant

Assistant is a special tool, that step-by-step helps to design a label, envelope or postcard from a ready-made
template. It is very helpful for beginners and when you need to get the result quickly.

When you launch the program, the Assistant comes up by default. In the program Preferences you can set
whether to launch the Assistant when the program starts.

To start Assistant when the program is launched, use:
Menu:     File/New from Assistant
Shortcut: Cmd+Shift+N

Assistant has 3 steps.

Step 1: Selecting a Layout

First of all choose what kind of document you're going to create - a label, envelope or postcard.

To create a label:
1.  Click on the Label tab at the top of the Assistant (selected by default).
2.  Browse through the list of supported label templates to locate the label paper you're going to use. To find
the necessary paper faster, just type the product part number in the Search field. To narrow the list you can
specify the Manufacturer, Paper size or Label Category.  The selected template is previewed in the preview
area to the right. Once you've found the needed label paper, click Next.

To create an envelope:
1.  Click on the Envelope tab at the top of the Assistant.
2.  Browse through the list of supported envelope sizes to locate the envelope you're going to use. To narrow
the search, use the pop-up list at the top left part of the Assistant. If your envelope has a window, you may
tick Use window box. The selected envelope is displayed in the preview area to the right.
3.  Once you've found the needed envelope, click Next.
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To create a postcard:
1.  Click on the Postcard tab at the top of the Assistant.
2.  Browse through the list of supported postcard sizes to locate one you're going to use. To narrow the list
you can specify the Manufacturer and/or Paper size.  The selected template is previewed in the preview area
to the right. Once you have found the needed postcard paper, click Next..

The Recently Used tab contains the list of label paper or envelope types you recently used.

It’s possible to change the paper type using the Layout window after you started working on your document.

If you don't want to use next steps of the Assistant click New Blank or Open button.
New Blank - opens blank layout, selected at Step 1.
Open - opens previously saved document.

Note: If the selected label is not a mailing label (e.g. a  "File Folder" or "Video Tape" label), the Assistant consists
only of Step 1.
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Step 2: Selecting a Design

Select a ready-made design from the list on the left. Designs are organized into categories, use the pop-up
menu at the top-left part of the window to switch between categories. When choosing a design in the list, you
can preview it in the preview area on the right, to proceed with the selected design, click Next. To design
your label or envelope from scratch, click the New Blank button.

Later you will be able to edit the design you selected.

Note: in contrast to labels and envelopes, pre-defined postcard templates come in pairs: for front and back sides. So
you will have to go through the Assistant twice to get both sides.

  

To return one step back click Prev button.
If you don't want to use the next steps of the Assistant click New Blank or Open button.
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Step 3: Specifying Personal Data

Specify the address(es) that will be printed on your label, envelope or postcard. Pay attention that you need
to choose both the Sender and the Recipient when you are creating an envelope or shipping label.

If you do not need to print address (for instance, on the front of a postcard), click the Finish button to skip
this step.

Sender, One Recipient and Multiple Recipients tabs represent data from external and embedded databases.

The contents of Sender and One Recipient tabs look similar. The right part contains a list of persons, the left
- editable fields with personal data of the person that is selected in the list.

Sender tab displays the Sender list, which refers to the contents of Sender database.
The program can use different sources of personal data for the Sender list. (At the first start only Apple
Address Book will be available because information from other sources must be imported before use.)
You just need to select a person in the list.
You can delete a person from the list by selecting it and clicking "Minus" button.
To add a new person, type new personal data into fields and click "Add To List" button.
You can also copy a complete address (or part of it) from an external text file to the clipboard and then click
Paste from Clipboard.
The Sender Database can be edited later from Contacts window.
For more information about Sender Database see Chapter 10.

One Recipient tab displays the data of persons from My Recipients (embedded database) or one of external
data sources: Apple Address Book (used by default), MS Entourage, Eudora, Now Contact, vCard Data
Source, Text File, MS Excel, FileMaker Pro. To find a name within the current list, type the name in Search
field below.
If address source as Text File is selected, this file can be reloaded by clicking Update button.
New data can be typed into fields manually or pasted from the clipboard.
You can also edit this data later via the Contacts window.
For more information about using database sources see Chapter 11.
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Multiple Recipients tab is used if you want to print more than one recipient's address. It refers to Print List
Database (see Chapter 10). It can be also viewed and edited via the Contacts window.

All personal data, selected at this step, can be edited later (see Chapter 8 and Chapter 10).
When all needed addresses are selected, click Finish if you want to continue working with the label or
envelope. It will be displayed in the application's main window.
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Chapter 5
Using Paper Layouts

Mail Factory uses the "Layout" (or "Paper Layout") term to call an envelope with the specific size or a specific
label paper type. Actually a layout is a numeric description of an envelope or label: width, height, size and
position of a window (for envelopes), number of labes on a sheet and size of gaps between them and other.
The numeric description is supplied with a picture for preview.

Users take as layout a piece of paper on which they design a label or an envelope.

Mail Factory comes with a large collection of popular label templates from major vendors, and supports the
most existing envelope sizes. Using one of them you don’t need to enter all dimensions – only find it in the
list on the Predefined tab.

To change a layout of an existing document, use the Layouts dialog.

The Layouts Dialog

Open the Layouts dialog
Menu: Format/Change Layout

The Layouts dialog contains three tabs: Predefined, Custom, Recently Used.
The selected template can be seen in the preview area to the right.

If you're going to use labels or envelopes, which are not listed in the Predefined list, you can create a custom
layout. The list with custom layouts is on the Custom tab.

The Recently Used tab contains the list of last labels or envelopes worked with. Use it for fast access to the
most frequently used layouts. All items can be deleted from this list by the Clear Recent button.

To find the necessary layout faster, enter its name in the Search field, or use the filters at the top of the
dialog. To narrow down the list you can specify the Manufacturer, Paper size or Label Category.
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If you click the Create Custom button, you'll be able to edit the layout and save it with a new name as a
custom layout. For more information, see "Custom Label Creation" and "Custom Envelope Creation"
subchapters.

Under the list of predefined envelopes you can see the Use window checkbox. The checkbox is disabled when
a selected envelope does not have window. When the checkbox is selected, you can see the position of the
window on the preview and on the envelope document.

To change the position of the window, click the Create Custom button, and set the window dimensions and
position in the dialog that comes up.
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Creating and Editing Custom Layouts

This dialog is used for creating and editing custom label layouts and envelope sizes. This may be necessary
when you need to print on non-standard label or envelope sizes.

Delete, Edit, Duplicate, Create New buttons at the bottom of the Custom tab let you work with the list of
custom layouts.

The Edit and Create new buttons open the dialog where you can edit dimensions of a label or an envelope
and some other parameters. The dialog looks slightly different for labels and envelopes.
The changes you make in the dialog can be immediately seen in the Preview area.

Tips for Creating Labels and Envelopes
If you need to create a label or envelope that is slightly different from the existing one, select the existing
label/envelope on the Predefined tab of the Layouts dialog and click Create Custom button. The parameters
of the new custom label or envelope will be equal to the selected one. Then make the needed corrections.

Creating a custom label for label printer is quite tricky because this printer uses label rolls. Therefore it is
recommended to use predefined label layouts.
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Custom Label Creation

Click the Create New button on the Custom tab of the Layouts dialog and you will see the following dialog.

In the Name and Description fields you can type the name of the layout and its short description. Size, name
and description will be seen in the custom layout list. So, it’s a good idea to make these fields descriptive as
much as possible.

The Paper size pop-up menu lets you choose the paper size - A4 or US Letter. In the Units pop-up menu you
can choose the measure units for dimensions - either inches or millimeters. You should set up units before
entering the numeric data, because changing Units leads to automatic recalculating dimensions to the new
unit.

The Size section contains the width, height of the label and corner radius (used for labels with rounded
corners).

The Layout section determines how the labels are arranged on the
page:
Columns and Rows specify the number of columns and rows of
labels on a sheet of paper,
Top margin - sets the distance between the top edge of the page
and the first label,
Left margin - sets the distance between the left edge of the page
and the first label,
Horizontal space - sets the horizontal distance between the
labels,
Vertical space - sets the vertical distance between the labels.

If you wish to print the labels on a plain thick paper and then cut them manually, you may only enter the
height and width of labels and tick the Arrange labels automatically box.

Click OK to save the layout. Now when you need it, click on the Custom tab of the Layouts dialog and select
your previously saved layout from the list of custom ones.
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Custom Envelope Creation

Click the Create New button on the Custom tab of the Layouts dialog and you will see the following dialog.

In the Name and Description fields you can type the name of the layout and a short description for it. Size,
name and description will be seen in the custom layout list. So, it’s a good idea to make these fields
descriptive as much as possible.

In the Units pop-up menu you can choose the measurement units for dimensions - either inches or
millimeters. You should set up units before entering the numeric data because changing Units leads to
automatic recalculating dimensions to the new unit.

The Envelope section describes the width and height of the envelope. If your envelope has a window, tick the
Enable window box and specify the window size and offset from the bottom and left sides of the envelope in
the corresponding fields.

Click OK to save the layout. Now when you need it, click on the Custom tab of the Layouts dialog and select
your previously saved layout from the list of custom ones.
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Chapter 6
Label Document Creation
This chapter is dedicated to creating and editing a label beginning with a blank document. How to create a
label using Assistant see Chapter 4.

Example 1. Address Label Creation
(on Avery #05159 paper,
with a person's name, company name, address and barcode, right aligned)

Step 1. Selecting a Layout
Open a new label document using “File/New Label” menu or press
Cmd+N.

Click the Layouts button on the toolbar. The Layouts dialog will
appear.
Type 05159 in the Search edit box and when Avery #05159 is
highlighted, click OK.

If your Mail Factory starts with Assistant (you can change this in Preference window), select the paper type at
the first step and click “New Blank”.

Using Zoom control make your label take all free space on the design canvas. But avoid scroll bars
appearing.

Step 2. Adding an Address Panel

Click Address Panel button on the toolbar. An address panel will be added to your document.

The program will apply address format that is the most common for the stated in the address country.
You may not write country name (only state or province) if your correspondence is local. In this case, you can
set country for the selected address panel via the Format/Country menu. This will help the program to
choose the correct address formatting.

It's possible to set the default country in the program for all addresses without country name. To do this,
open the program preferences through the "Mail Factory/Preferences" menu, switch to the Address Panel tab
and choose country in the pop-up menu.

Click on the right side of the panel tag and select “Name+Company” from the list. You can also find this list
in the menu: "Format/Address Template".

Note: you have another way to add “Name+Company” address panel to the document. Open the Design window
(Design button on the toolbar) switch to Address templates tab and drag “Name+Company” panel from the list to the
document.

Now we will fill the address panel with a recipient’s address. Open the “To” tab in the Contacts window
(Contacts button on the toolbar). Make sure you have a delivery (not return) panel – at the left side of the
panel tag “To” must be shown. Select the needed name in the Contacts window. If you don’t have the
necessary personal information you can import it from external contact manager.

To enter address manually, click on an address field (for example, “First Name”). The program will switch to
editing mode. Type the name in. And so on.

If you have an address in a text file, e-mail or somewhere else (in text format), copy the address to the
Clipboard. Then select “Edit/Paste As Address” in the menu, the program will help you to paste data into
correct fields.
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For more information about Address Panels see Chapter 8.

Step 3. Arranging the Address Panel

Open the Inspector window (Inspector button on the toolbar). Select the address panel (not a separate field).
Use Size slider to make the font bigger (the address panel will be resized), set font size 14.
If you select a separate field on a panel, only its font size will change.

Drag the address panel to the top right corner until two guidelines appear. Don’t cross them to have blank
border between text and the edge of the label.

To set right alignment for the panel click the right Alignment button in the Text section of Inspector.

Step 4. Adding a Barcode

Mail Factory supports barcodes for the limited number of countries.

To add a barcode select an address panel and tick Barcode checkbox in Inspector. (For unsupported
countries Barcode is disabled.) Then select the “Below Address” radio button.

If barcode is disabled in Inspector, see what country is selected in the Format/Country menu (the menu
should not be grayed out).

Note: every time you design a label or envelope document, remember about the Postal Service recommendations.
They concern font type and size, spaces between lines and other items. These recommendations can differ from
country to country.
For more information about Postal Guidelines see Appendix A.

Printing

You can print your labels on virtually any laser or inkjet printer. Click Print button on the toolbar, Print dialog
will come up. At the left part of the dialog you can preview your document. At the right part you can select
printer, set starting position, number of labels to print, etc. If you're going to print multiple addresses, you
can select a print list at the top-bottom corner of the window.
Click Next button. System print dialog, with selected Copies&Pages option, will come up for setting printer
options (such as print quality, etc). Finally, click Print button.

If your labels don't line up correctly on the label paper, it means that you need to calibrate the printer. Go to
Printer Calibration from the File menu, and follow the instructions in the dialog that will come up.

For more information about printing see Chapter 9.



Mail Factory User’s Manual Label Document Creation

BeLight Software, Ltd   www.belightsoft.com Example 2. Creating a To-From Label with Graphical Design 33

Example 2. Creating a To-From Label with Graphical Design

We are going to create a label with delivery and return
addresses that has design like “Checked” ready-made
design from Assistant (“To and From - Filled” category).

Open a blank label Avery #05163 (how to do this see
Chapter 6, Example 1).

Step 1. Adding Graphics

Open the Design window (Design button on the toolbar).
Open the “Image Collection” tab and “Smart Shape” tab
in it.

Find a Rectangle shape and drag it to the document. We will create the outside frame
(border). Move the rectangle to the top left corner of the label until you see two blue
guidelines. Resize the rectangle, so it extends till the bottom and right guidelines.

To make a frame from the rectangle open Inspector and uncheck Fill checkbox
and check Line. Click Color button in the Line section of Inspector to set brown
color for the rectangle.

Add another rectangle and make it taking about 2/5 of the left part of the frame
rectangle. Set it’s Fill checkbox and uncheck Line.

Leave it the same color as frame. Open the Colors panel. Select frame rectangle
(the sample color). Its color will appear in Line section of Inspector. Drag and
drop this color from the Colors panel to the rectangle you want to set color.
Select Format/Send to Back, because it will be the background for other shapes.

Add another rectangle. Make its width about 1/3 of the filled rectangle. Move it to the
bottom of filled rectangle.

Now we need to make two copies of the new rectangle. Select it, call a context menu and
select Duplicate, a copy of the rectangle will appear. Make another copy.

Place three little rectangles side by side at the bottom of the brown one. If you need,
adjust their width. They must be equal and cover the bottom of the bigger one. Set their
colors: dark yellow, brown and red.

Duplicate three small rectangles. Place copies above the source rectangles with the same
color with a gap. Downsize copies so that they have the same height as the gap.

Now add a filled circle from the Smart Shapes. Make its diameter about 3/4 of the width of
the bottom rectangle. Move the circle to the top left corner of the label. It should be on
the imaginary line that connects the diagonal corners of the filled big brown rectangle.

Press Cmd+D three times on the keyboard to duplicate it for the following work. Make
diameters of three new circles about 3/5, 1/2 and 1/3 of the source rectangle moving a
corner handle of each.

Set the color of the bigger circle equal to the middle rectangle. Other must be: “3/5” – brown
as filled rectangle, “1/2” – red as red rectangle, “1/3” – brown as the bigger circle.

Place the smaller circle between the bigger one and the top left corner of the label. Place the “3/5” circle
over the bigger one and the “1/2” over “3/5”.
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The program menu has the group of commands that are very useful now:
Bring Forward (Cmd+Option+F);
Bring to Front (Cmd+Shift+F);
Send Backward (Cmd+Option+B);
Send to Back (Cmd+Shift+B).

Use them to move selected objects above or behind other objects.
On the picture with three circles the selected red circle is under the light brown one. To make it above, use
the “Bring Forward” command.

To position the circles one above another more accurately, use arrow keys on the
keyboard.

Add a “Horizontal Line” from “Smart Shape” tab to the document.  Make its left
end touch the edge of the bigger circle. Pull the right end to extend the line to the
edge of filled rectangle. You can leave thickness 1.00 or change it if you like. Color
it as the bigger circle.

Now our graphics is ready.

Step 2. Adding Address Panels

Let’s add a recipient’s address.

Click the Address Panel button to add an address panel.

Select “Name+Company” address format on its tag. Select right alignment in Inspector for this address
panel.
Move the “To” panel to the bottom right corner of the label. Leave the gaps to the brown frame wide enough.

In the Contacts window select a recipient name on the “To” or “Print List” tab. If you want to modify personal
data, double click on a person or click the “Edit…” button.
If you don’t have the needed contact data in the Contacts window, type an address into address panel, add a
person to one of the embedded databases or import data from an external source.

Set font size 10 and select right alignment in Inspector.

Now we’ll add a sender’s address.

Click the Address Panel button. Click “To” on the tag and select “From”, it will became a return address
panel. Move it to the left part of the label. Align it with the left edge of the bigger circle (when you will see a
vertical blue guideline stop moving it horizontally). If Snap checkbox in Preferences is selected, program
helps to align objects.

Select a person in the From tab of Contacts.
Use Color button in Inspector to set the same red color as a rectangle at the bottom has.
Click Font button in Inspector and select bold font for the return address.

Click on the first name on the "To" address panel and
select it.
Set red color for the first name – the same as the color,
used for “From” panel.
Press Cmd+B to make the name bold.
Do the same for the last name.

Our label is ready.
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Example 3. A Price Label Creation

Let’s create a label for a book store. It will show book title, ISDN code and price. All book-specific data will
be taken from an external database. For example, MS Excel. The sample of the database is shown in the
table CH5.1.

Table CH6.1

ISBN Title Author Price
0823056600 Watercolor for the Serious Beginner Mary Whyte 13.57
0471288349 Graphic Design School Alan Swann 39.95
0471291986 A History of Graphic Design Philip Meggs 69.16
0735709181 Digital Texturing & Painting Owen Demers 55.00

We will use APLI #01282 paper for the label.

Mail Factory is flexible enough application for designing not only for address labels. We will use Custom
address panel, because Mail Factory primarily is a mailing program and its standard address panels do not
suffice our needs.

Step 1. Adding Objects to the Label

Open a blank label with APLI #01282 layout (see Chapter 6, Example 1).

We start with adding a custom address panel. Select Format/Customize Address Panel menu and then Add,
address panel template editor will come up.

Type “Price label” in the “Format name” field.
Delete all fields using Clear button.

Add to the following fields:
First  - for the book title;
Custom1 - for ISDN code;
Simple Text – for $ sign;
Custom2 - for the price.

Click OK.

Add an address panel using the Address Panel button (it must be “To” panel, see Step 2 for explanation).
Click on the right side of its tag and select “Price” as address panel template (also you can use menu:
Format/Address Template).  Move it approximately to the center of the label.

Step 2. Importing Data from the External Database

To fill the address panel fields we need to import data from Excel.

Open Contacts window (click Contacts button on the toolbar), Print List tab. We will
use  “Multiple Printing” feature for our task because we need to print many labels
taking different data records from the database.

Click “Edit Print List” button to enter print list editing window. Click «Plus» button
under “Print List” list. Type “Pricelist” as the print list name.
In the Source of the Address Source section select MS Excel. If you have imported
from Excel before, click Update (if not, “Open File” window will come up
automatically). Select your database file and click OK.

Now you need to match external data to our fields.
Check “The First Row is a Header” because we have a header in Excel file.
Map ISBN to Custom1 (in the “Map To” click the cell against ISBN and select Custom1 in the pop-up menu).
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Map Title to First.
Map Author to – (because we won’t use this information).
Map Price to Custom2.

Click Import. All names of books will be listed in the “Address Source” list. To add all of them to
“Pricelist” print list press Cmd+A and click Arrow button or drag them to the print list. Click OK to close the
dialog.

Step 3. Finishing the Label

Move the address panel to the left edge of the label.
Click on the “Show Blank Fields” button of Inspector to make Simple Text field visible. Enter a dollar (or
other currency) sign there.
Set the size 10 for the book name font, ISDN and “$”, for price - 20.
Select Format/Move to Center (vertically) from the menu.

From the Clipart, “Education & Schools” section, add any image with a book to the bottom right corner and
resize it to cover free space.
In the end you will have the following result.

You can choose Multiple Printing to print price labels for all books. Or use the Print option to print multiple
copies of a label for the same book.
For more details about printing see Chapter 9.
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Chapter 7
Envelope Document Creation

This chapter is dedicated to creating and editing an envelope design starting from a blank document. See
Chapter 4 about creation an envelope document using Assistant.

Example 1. A Simple Envelope Creation

We will design an envelope with delivery address, return address and barcode.
Let’s use envelope size #10 (Commercial).

Step 1. Selecting a Layout

Open a new envelope document using “File/New Envelope” from the menu or press Cmd+Opt+N.

Click Layout button on the toolbar.
Select envelope #10 and click OK.

If your Mail Factory starts with Assistant (you can change this in Preferences window), open Envelope tab,
select envelope #10 and click “New Blank”.

Step 2. Adding Address Panels

Сlick Address Panel button on the toolbar to add an address panel and move it to the right. This will be for
delivery address panel.

Add another panel. Look at its tag: there is “To” at the left part. This means that the selected panel is for
delivery address. As we need to have return address here, click on “To” on the tag and select “From“ in the
pop-up menu. You can also switch between “To” and “From” using menu: Format/Refers To.

Let’s use “Name” address panel template for the sender panel.
Click on the right side of the panel tag and select “Name” from the list. You can find this list in the menu:
Format/Address Template.

Note: here is another option to add “Name” address panel to the document. Open the Design window (Design
button on the toolbar), switch to Address templates tab and drag “Name” panel from the list to the document.

Move the sender panel to the top left part of your envelope.

Now we need to fill the address panels with data. Open “To” tab in the Contacts window (Contacts button on
the toolbar). Select a recipient’s name you need in the Contacts window.
Then open “From” tab and select sender's name.
If you don’t have the necessary personal information in the Contacts window, you can import it from an
external contact manager or enter manually.
To enter address manually, click on an address field (for example, “First Name”), the program will switch to
the editing mode. Type the name in. Press Tab to switch to the next field.

If you have an address in a text file, e-mail or somewhere else (in text format), copy the address to the
Clipboard. Then select “Edit/Paste As Address” in the menu. The program will help you to paste data into
corresponding fields.
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Step 3. Arranging the Address Panels

The envelope, we are using, is quite large. So it’s possible to make fonts in the panels bigger.

Open Inspector window (Inspector button on the toolbar). Select the address panel (not a separate field).
Use Size slider to make the font bigger (the address panel will be resized). Set font size 14 for both panels.

You can move address panels quite freely on the envelope document but to make your envelope
machine-processable, place address panels within the recommended areas. Use “View/Show Postal
Guidelines” menu command to have these areas marked. Mail Factory will not print Postal Guidelines. For
more details about Postal Guidelines see Appendix A.

Step 4. Adding a Barcode

Mail Factory supports barcodes for the limited number of countries.

To add a barcode select an address panel and tick Barcode checkbox in Inspector. (For unsupported
countries Barcode is disabled.) Then select the “Below Address” radio button.

If barcode is disabled in Inspector, see what country is selected in the Format/Country menu (the menu
should not be grayed out).

Note: each time you design a label or envelope document, remember about the Postal Service recommendations.
They concern font type and size, spaces between lines and other items. These recommendations can differ from
country to country.
For more information about Postal Guidelines see Appendix A.

The envelope is ready.
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Printing

You can print your envelopes on virtually any laser or inkjet printer. Click Print button on the toolbar, Print
dialog will come up. At the left part of the dialog you can preview your document. At the right part you can
select printer, number of envelopes to print, etc. If you're going to print multiple addresses, you can select a
print list at the top-bottom corner of the window.
Click Next button. System print dialog, with selected Copies&Pages option, will come up for setting printer
options (such as print quality, etc). Finally, click Print button.

For more information about printing see Chapter 9.
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Example 2. Creating an Envelope with a Background Picture

Open blank #6 (Commercial) envelope. See details in Chapter 7, Example 1.

Step 1. Adding Graphics

Open Clipart in the Design window and select “Design and Technology” in Clipart pop-up menu. Drag an
image (for example, “Space Station”) to the document.

We have to use dark side of the picture for return address and light for delivery address because the delivery
address must be well readable.

We have several ways to do this.
The first: we can turn “Space Station” upside-down using the rotation tool (this will cause no problem to
astronauts – they’re trained).
Open the Inspector window and select the image, then use the Rotate slider or edit box to set rotation angle.

For the most objects (like animals, cars, etc.) this option is not the best to use. For them Flip operation is
prefered use horizontal Flip.

Move the upper left corner of the image to the upper left corner of the envelope.
Drag the right and bottom selection handles of the image to resize it so that it fully covers the envelope.
If your printer can’t print without borders (this is true for the most printers), use a mask to smooth the edge
of the image.
For this, select the background image, open the Inspector window, set the “Mask Image” checkbox and
select “Square” mask in the mask list of Inspector.

Step 2. Adding Address Panels and Setting Their Color

Click the Address Panel button on the toolbar to add a recipient address panel.

Move it to the right part of the envelope. Set font size 11 in Inspector. Enable the "Back color" checkbox, then
click Color button in the Text Format section of Inspector and select white color on the Color panel. The color
of text should be black, as we need to have the recipient address well readable.

Add another address panel for sender address. A “To” address panel was added. Click “To” on its tag and
select “From”. Place the sender's panel (“From”) at the top left corner.

Select this panel and click the Color button in the Text Format section of Inspector. Select white color for
text. Press Cmd+B to get bold font.

Note: white text on black background can not be printed wery well on inkjet printers. In this case it's better to make
black text on white background.
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See Example 1 for details about person selection and about printing.
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Chapter 8
Postcard Document Creation

Postcard creation is bases on using same tools and technique that are used for envelopes and labels.
Most postcards have images or/and text on both sides. So, to create a postcard like one from internal
templates, you will have to create two documents – one for every side.

Front Side

What will be on the front side of the future postcard is the matter of your taste and, of course, depends on
the event to wich the postcard is dedicated.
You can design the front side of your postcard as you want.

To begin, look through ready-made templates in Assistant (Cmd+Shift+N). Maybe you will get an idea of your
own design.

Back Side

The back side of the postcard usually has delivery and return addresses. The delivery address must comply
with the Postal Service rules. For more information about these recommendations see Appendix A.

Back side creation and printing is very similar to the envelope creation process. See "Example 1. A Simple
Envelope Creation" from Chapter 1 for more details.

Printing

Since you are going to print postcard by yourself, consider your printer capabilities at the early phase of the
design process.

Print quality and colors

To get postcards printed fine, use special paper for postcards or photo paper. This is essencial for the front
side where colorful pictures and text are located.

Calibrate your printer to avoid unnecessary picture shift at printing.

Borders

Some printers can print from edge to edge, some cannot.

Usually printers have non-printable area along all sides.
If your does too, keep this in mind:
1. If you plan to cover your postcard with an image fully, choose paper that has borders around cards like on
the picture below.
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For the best result, make the background image slightly go over card borders. This will help to avoid deffects
if the printer print the picture with slight shift.

2. If you will print on paper where card edges coinside with the sheet edges, leave blank borders along your
card edges.

Or, to make your postcard more artsy, apply a mask to the background image. The background image will
fade out to the postcard edge smoothly.

Make test print to define the borders width your printer leaves blank.
a) Open a blank document and create a custom layout with page size you plan to use. For instanse, if you will
print 4 cards on the Letter size paper, set Width to 8.5" and Height to 11".

b) Place on the page a rectangle from the Smart Shapes collection (View/Smart Shapes menu). Make the
rectangle slightly bigger than the page (it must cover the page fully). Set the Fill checkbox on the "Fill and
Shadow " tab of Inspector. Choose color light gray (to save ink or toner).

c) Print the test document. Make border width on your postcards equal or greater than the widest blank
border on the printed sheet. Usually the bottom unprintable area is bigger than others.

If you are using a borderless printer and want to use this printer's capability:
1. Make sure your printer supports borderless printing for the paper size you are going to use.
Refer your printer documentation or see paper list in the printer driver (see the next paragraph).

2. Before printing, open the Page Setup dialog (via the File menu) and select a paper that marked as
"borderless".

For the best result, make the image slightly go over card borders. This will help to avoid deffects if the
printer print the picture with slight shift.
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Chapter 9
Working with Objects
You can compose your documents in Mail Factory using the following kinds of objects.

Text Fields: A piece of text can be placed on a label or envelope as a text field. This can be a Personal Data,
Simple Text, Counter, File Data or Custom Text field.

Address panels: Address panel is a single object for keeping the entire address. Address panel consists of a
group of personal data text fields.

Images: You can use vector and raster images in Mail Factory.

Smart shapes: Vector images supplied with the program. Unlike other vector images from clipart, some
more their parameters can be adjusted.

Basic Operations on Objects

Some portion of operations can be performed on all objects in Mail Factory and another one only on a
particular kind of them0.
In this subchapter common operations are described.

Moving

To move an object, drag it with the mouse.
For more precise movement, select an object and move it using arrow keys on
the keyboard.

When you move an object using the mouse, it snaps automatically to the
label/envelope border or other object edges, and smart guidelines are
displayed. This helps to position the object more accurately. You may toggle
the Snap function by holding down the Cmd key as you move an object. To
turn it off permanently, use the Preferences dialog.

Size and Orientation

To resize an object, select it and use resize handles at its sides. To resize an object preserving its
proportions, use corner resize handles. Side handles resize particular side only. To inverse the action of
corner handles, hold down the Shift key.
To resize a text in Address panel or in a text box use the Size slide bar in the Inspector window. As the result
the address panel becomes bigger or smaller by changing the font size.
To change the orientation of the selected object (except address panels), use the Rotate slide bar in the
Inspector.
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Alignment

If you need to align edges or centers of several objects, select them all and use Align Right Edges, Align Left
Edges or Align Centers commands from the Format menu.
Commands Move to Center (Horizontally) and Move to Center (Vertically) from the Format menu help in
moving selected objects to the center of a label or envelope.

Sometimes you may need to place one object behind another.
This is especially convenient when you use an image as a
background. Use Send Backward and Bring Forward
commands from the Format menu for this purpose.  Send
Backward command puts selected object behind the other
objects. Bring Forward command places it in front of all other
objects.
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Working with Text

In Mail Factory, you can place a text on your envelopes and labels. This can be done in several ways.

• To create a new text object click "A" button on the toolbar and then on the document.

• The alternative method:
1.  Bring up the Design window by clicking the Design toolbar button, or choose Show Design from
the Window menu.
2.  Choose the Address Fields tab and drag "Simple Text Field" to the document and drop where you
want the text to be inserted.
3.  Type in the text. When done, click away from the text box.

• One more option to add a text box is to copy a piece of text to the Clipboard. Then open the context menu
on your label or envelope (mouse click with pressed Ctrl key) and select Paste. In a new text box text from
the Clipboard will be pasted.

To modify the text, double-click on it. To quit the editing mode, click outside the text box.

You can change the font attributes and color of the text inside a text box or an
address panel by using the system Fonts and Colors dialogs.  To call the Fonts
dialog, press Cmd+T or choose Show Fonts from the Window menu. To call the
Colors dialog, press Cmd+Shift+C or choose Show Colors from the Window
menu.  If the entire address panel is selected, the changes you make in the
dialogs will apply to the entire address panel. If a portion of text is selected, the
changes will apply to the selected text only.

You can also use Inspector to change the color, alignment and background color
of the text. To open the Inspector, click the Inspector toolbar button, or choose
Show Inspector from the Window menu.

To change the address to all caps, click the Capitalize button.

To rotate a text box, select it and use the Rotate slide bar or type the angle into the Rotate edit box.
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Working with Address Panels

Address panel is a special object for working with an entire address in
Mail Factory. It consists of a group of text fields (address fields) and a
barcode. Each field has its type (such as Name, Company, City, ZIP, etc.).
Address panel behaves as a separate object.

Address panel can be filled with address information either manually, or
pulled from a contact manager - Address Book, MS Entourage, MS Excel,
Now Contact, vCard, FileMaker or from a tab- or comma-delimited text
file. Address fields are assembled into Address Panels according to postal guidelines (distance between
fields, text size, etc.). Fields order depends on country, selected address template, fields filling in databases
and changes automatically when a person is changed through Contacts Window.

Address Panel Creation and Deleting

There are several ways to add an Address Panel:
1.  Initially Address Panel with filled fields appears in new document after using Assistant. If you create a
Shipping Label or an Envelope, you will get two panels: Sender
and Recipient.

2.  Another method of creation a panel is to click Address Panel
button, which is located at the bottom part of the main window. A
“To” address panel will be added.

3.  The third way is to drag a panel from the Design window,
Address Templates tab, and place it on a label or envelope.

4.  Finally, you can group text fields yourself (using Edit/Group menu). This method is used for creating
panels with a particular address fields allocation, that are not provided in the program. Alternatively you can
add any address panel and then change it to the one you need using Address Panel Format dialog.

5. The program menu has two separate options for adding address panels:
Edit/Insert Sender Address (Cmd+Shift+A)
Edit/Insert Recipient Address (Cmd+Opt+A)

Some of listed above methods explain how to  "To" to "From"
address panel.
To do this, select the panel to have visible its tag. Click "To"
on the tag and choose "From" in the pop-up menu.

Another way to switch between sender and recipient panel:
select an address panel, open the menu "Format/Refers To" and select Sender or Recipient.

If a new address panel contains no data, names of data fields while be shown in gray.

To fill an address panel with an address, click on the Contacts toolbar button to open the Contacts window
and choose a person there. For “To” address panel you need to open “To” or “Print List” tab of the Contacts
window. Contact information to fill “From” panel can be selected via the “From” tab of Contacts window.

Alternatively, you can type the address manually - click on a field inside the address
panel and type the address info there. Use Return key to insert a line break, and
Enter key to finish editing.
Use the Tab key to move from one field to another.

If you have an address as a simple text block (in the e-mail body for instance) - you
can copy it to the clipboard and paste using menu “Edit/Paste As Address”. The
new address fills the selected panel (or creates the new one). Before the address is
pasted into an address panel you will be able to review it and change if necessary.
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Address panel, as any other object can be deleted by Delete button. It can also be broken into separate
fields with Edit/Ungroup menu.

Address Panel Properties

Address panel can reflect Recipient ("To" panel) or Sender ("From" panel) data. The only differences are that
the postal limitations on address creation are not applied to Sender Panel and no barcode can be added.

The delivery address format should correspond the Postal Service recommendations, which concern font
type and size, spaces between lines and other items. These recommendations can differ from country to
country.
For more information about Postal Guidelines see Appendix A.

Data to fill Sender's panel is taken from the internal Sender Database - active record is shown in Contacts
Window, From tab. For more information about the Contacts window see Chapter 10.

Data to fill Recipient is taken from one of external sources (e.g. Apple Address Book) or internal Print List.
For more information about import from external contact sources see Chapter 11.

Each address panel is built according to a particular pattern that
takes account of field order. Viewing and editing an address
template can be done by clicking on the template tab (on the right
side of the address panel tag). Template purpose can be identified
by its name. For example, "Company+Attention" template places
Attn in front of person's name, the template "Family" - creates
address heading "The ... Family"
If you'd like to make a special template, use “Format/Customize
Address Template” menu to call the Address Panel Format dialog.

Many address panel properties can be altered using the Inspector
window. To open it, click the Inspector toolbar button, or use Show
Inspector command from Window menu.

Some of the address fields (e.g. country field) can be switched on/off from pop-up
menu of "Address Fields". Use this if you don’t need to have some contact data
shown on the address panel.

As a person's record may have more than one address location (for instance, "work"
and "home"), you are given an option to choose which one to use from the "Preferred
Address" pop-up menu.

Mail Factory hides blank fields (not filled in the source) in address panels. To enter
data you need to have them visible, for this, click the "Show Blank Fields" button.
You can enter any text instead of grey fields. If unchanged, grey fields will not be
printed.
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In the ON/OFF pop-up menu all fields of a selected address panel are listed. If you want to hide an address
field, uncheck it in the list.

To have the address written in capitals, click the Capitalize button.

If a panel is designed for Recipient, you can turn on Barcode and set its
positioning. The program does not support barcodes for all countries. Barcode
is disabled or enabled depending on the country format that is set for the
selected address panel. (See the Format/Country menu)

The size of the address panel is determined by the size of the text inside it.
When you increase or decrease the font size, the address panel is resized
accordingly. Use the Size slide bar to change the size of the address panel.

You may also change the formation of an address in the address panel, so that
it confirms to various country standards. Choose a country in the Country list in
the Format menu, the fields in the address panel will be formatted according to
that country postal standards. Apart from preset country formats you can
choose a custom format, which can be set in the Address Panel Format Dialog.
(See the “Format/Customize Address Panel” menu.)

You can change various font attributes of the text inside the address panel.  For
more information about this, see Chapter 8 "Working With Text".

The program has a special option for the street address field: "Set street field
in a line". The option is available in the program preferences (Address Panel
tab). When it is enabled, multi-line addresses are shown in one line. The option
affects separate Street fields as well as Street fields in address panels.
The option can be used when:
1. You need to format automatically two-line street addresses into one line.
2. To get rid of blank line(s) after street address. Sometimes addresses with blank lines can be exported
from extrnal data sources.

Group and Ungroup Commands

Group and Ungroup commands are used to create an address panel with special field order.

The Group command creates a Custom Address Panel Template from separate text fields.
The Ungroup command breaks the selected address panel into separate text fields.

To create a custom panel, drag fields from the
Design window and drop on the label or envelope.
You can use any combination of fields and arrange
them as you want. When it is ready, select these
fields and click Group in Edit menu to create an
address panel from them.

It is possible to create custom address panels based on one of the predefined panel templates.
For example, you want to add e-mail to "Name+Title+Company" panel.
Select the panel and click Ungroup in the context menu. Drag and drop "Email" field from the Design window.
Select all fields that you are going to add to the new address panel, then click the Group command in the
context menu. The new custom address panel will appear.

Group text fields
Menu:         Edit/Group
Shortcut:     Cmd+G
Context menu: Group

Ungroup an address panel
Menu:         Edit/Ungroup
Shortcut:     Cmd+Shift+G
Context menu: Ungroup
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Custom Address Panel Template Dialog

Different countries use different rules for
address writing. The way the address looks
in Mail Factory is determined by fields
arrangement in the Address Panel. By
default, Mail Factory automatically formats
the address depending on the country field.
However, you may want to use custom
address formatting in some cases - for
instance, when designing an envelope it's
sometimes convenient to have the return
address in one line.

The Address Panel Format dialog allows you
to edit and save custom address panel
templates.
1. To call the dialog, choose Customize
Address Panel... from the Format menu.
This will be applied to a selected address.

2. To apply a template to the selected address panel (if it exists in the list), choose the template in the list
and click Apply.

3. To create a new template, click the Add button.

4. The edit window will open. Enter a name for the new template. Drag the fields from the left part of the
window onto the grid and arrange them how you want the fields to be placed in the address panel. To delete
a field, drag it to Trash at the bottom-right corner of the window. You can also move fields to other places.
When ready, click OK.
A new template will be added. Now you can click Apply.

When you change the address template by using the Address Template list from the Format menu (or the
context menu), your custom templates are located at the bottom of the list below the prepared templates.

It is possible to have several custom address panel templates.
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Working with Text Fields

Text fields are used to display personal data (address and other information).
Address Panels are created with them.

Text fields can be divided into several types:
Personal Data - fields for data such as name, address, telephone, etc. These fields
correspond to Apple Address Book fields.
Counters - fields for automatic document numeration.
File Data - fields to insert data from a text file.
Simple Text – fields for some text. They don’t have links to contact information in
databases. So they stay unchanged when you move from one person to another in
a person list.

There are two ways for adding a text field.
The first way is to drag a panel from the Design window, Address Fields tab, and
place it on a label or envelope. You can choose a text field type you need.
The second way is to add a text using Text Edit tool (A), located in the lower left
part of the program window. In the upper pop-up menu of the Inspector window,
change field type (e.g. Personal Data).

Personal Data Fields

Personal Data can be filled with address information either manually, or pulled
from a contact manager - Address Book, MS Entourage, MS Excel, Now Contact,
vCard, FileMaker or from a tab- or comma-delimited text file. Addresses change
automatically when a person is changed through the Contacts window.

To have a personal data filled, click on the Contacts toolbar button to bring up
the Contacts window and choose a person from there.
Alternatively, you can type in the data manually. Add a text field using the Text
Edit tool (A) and fill it manually. Use Return to insert a line break, and Enter - to
finish editing.

Text field, as any other object can be deleted by Delete key.

Text field properties can be altered from the Inspector window. To open it, click
the Inspector toolbar button, or use Show Inspector command from Window
menu.

Personal Data field can reflect Recipient or Sender data. Switching between
Sender and Recipient data can be done using Inspector window, Refers To
option.
Data to fill Sender is taken from the internal Sender Database - active record is
shown in the Contacts window, From tab.
Data to fill Recipient is taken from one of external sources (e.g. Apple Address
Book) or internal Print List and My Recipients.

Mail Factory supports a lot of data fields. To see all of them, you need to open
the Address Fields tab of the Design window (menu: View/Address Fields). But not all can be found on
standard address panels. Address panels represent the most common address data.

For example, you want to use a telephone number stored in Apple Address Book. Drag it on your label (you'll
get a separate fields). By default, such field shows data of a selected in the Contacts window recipient. You
can switch this field to display sender's data. For this, open the Inspector window and set the Sender
checkbox (a data field must be highlighted).

You can drag several data fields from the Design window and group them into an address panel. To do this,
select them with selection frame, call a context menu and choose Group (or press Cmd+G). See details in the
"Working with Address Panels" subchapter.
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To add a field to an existing address panel, select this panel, call a context menu and choose Ungroup. Then
place an additional data field somewhere near existing and group all these fields.

Personal Data type can be changed (e.g. phone to fax) using Type pop-up menu in Inspector.

As a person's record may have more than one address location (for instance, "work" and "home"), you are
given an option to choose which one to use. Use the "Preferred Address" pop-up menu.

To have the data written in capitals, click the Capitalize button.

You can change various font attributes of the text inside the address panel.  For more information on this,
see "Working With Text".

The program has a special option for the street address field: "Set street field in a line". The option is
available in the program preferences (Address Panel tab). When it is enabled, multi-line addresses are shown
in one line.
The option can be used when:
1. You need to format automatically two-line street addresses into one line.
2. To get rid of blank line(s) after street address. Sometimes addresses with blank lines can be exported
from extrnal data sources.

Counter Fields

Counter fields are used for automatic label or envelope numeration while printing.
To add counter, add a text field using the text tool from the toolbar and when this
field is highlighted, choose Counter option from pop-up menu in the Inspector
window.

It is possible to set Starting Number from which counting starts and increment
value (e.g. if you would like to obtain figures raw 010, 020, 030, 040 and so on -
you would have to enter 10).
For obtaining figures with the same number of digits (e.g., consisting of 4 digits)
leading zeros are added to them. This can be set by Make N digits (use leading
zeros) option. In this case number 3 will look like 0003, and 346 will look like
0346.

Note that numbers aren't displayed in editing mode, but will appear in Print Preview and when printed.
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File Data Fields

File Data fields are used for automatic data insertion from a text file. To add such fields to a label or
envelope, choose Text tool (A) and choose File Data option from pop-up menu in the Inspector window.

To select a source file click the Browse button in Inspector when File Data field is selected. You can also
specify a kind of delimiter.
If you choose Read each line option - data will be read for each line, starting from the first line.
If you choose Read as delimited option - data will be read according to delimiters.

Lets examine a file that includes the following lines:
001,Russell Simmons,Manager,347-12-567
002,Shirley Kaiser,Accountant,653-54-444

For this file, you should choose comma as a delimiter (from pop-up menu). To display the field, e.g.
Occupation - number 3 should be entered in Column field of Inspector Window (because the first in each line
is the index number, the second is name, and the third is occupation).

Note that text data from files is not displayed during editing, but will appear in Print Preview and when
printed.

Note: In fact, you can use Personal Data, option to fill text fields then use a text file as an external source. File Data
will be kept unchanged, if it is necessary to take data from several files simultaneously.

Simple Text
Simple text fields can keep any text you need.
They don’t have links to contact information in databases. So they stay unchanged when you move from one
person to another in a person list.
You can use Simple Text fields when you need to have some text unchangeble while Merge Printing (personal
data will change from person to person).

If information you want to use on a label or envelope can’t be represented using special field (Personal Data),
use Simple Text for it.
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Working with Barcodes

Mail Factory can print postal barcodes on labels and envelopes. The supported
barcodes are: POSTNET, used by United States Postal Service, the Royal Mail
barcode, used in the UK, and Canada Post Bar Code. The Postal Service is equipped
with automation equipment, which recognizes barcodes to sort the mail. This
means that your mail will be scanned and sorted by machine rather than
manually, which means faster and more reliable service.

Barcodes can be used only with recipient's addresses. The barcode is based on the
ZIP code (Postal code) characters, so make sure you enter the ZIP code correctly.

Barcodes are located inside the Recipient address panel - either above or below the
address. For envelopes, you can also place the barcode at the bottom-right corner of an envelope. You will
not be able to add a barcode to the Sender address panel.

To enable/disable the barcode:
1.  Click inside the Recipient address panel to select it.
2.  Open the Inspector window by clicking the Inspector toolbar button, or
choose Show Inspector from the Window menu.
3.  Tick the Barcode check box in the Inspector window. Select the barcode
position - above or below address. For envelopes, you can also choose the
position at the bottom-right corner of the envelope.

You can also drag a barcode from the Design window (Address Fields tab) and
drop it on your document.

Mail Factory can also print FIM on envelopes. FIM (Facing Identification Mark) tells automated processing
equipment the data it requires to do its job. FIM allows automatic facing (orientation) of the mail for
cancellation (postmarking). FIM is not essential, and is only used with barcoded mail. There are 4 types of
FIM codes. Mail Factory supports FIM-A code. Other types are used exclusively for business reply mails.

By default, Mail Factory allows to print FIM-A code on envelopes with US addresses that bear POSTNET
barcode. To turn FIM on, choose Show FIM-A in the View menu.

The ability to add a barcode and what format was used depends on the
country selected in the program. For example a US barcode can be
added to an address panel with US format address.
To change country format for a selected address panel use the
“Format/Country” menu.
You can select the default address format in the Preferences window
(“Mail Factory/ Preferences” menu).

For more information see “Postal Resources in the Internet” on the
BeLight Software site:
http://www.belightsoft.com/products/resources/postal.php
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Working with Images

In Mail Factory you can use either supplied with the program images (clipart and "handling labels"), import
an image from a graphic file, use pictures from your iPhoto library or find and download images from the
Internet.

Adding an Image

To insert an image supplied with Mail Factory:
1.  Open the Design window by clicking the Design toolbar button or choosing Show Design from the
Window menu.
2.  Click on Clipart pane from Image Collection tab or Handling Labels tab of the Design window.
“View/Clipart Collection” menu command also opens the collection of images in Clipart.
3.  Drag a picture to your document. Or click on the picture on the Clipart panel and it will be inserted into
the center of the document. Images are organized into categories, which you can change by using the pop-up
menu at the top of the panel.

To insert an image from the iPhoto library:
1.  Open the Design window by clicking the Design toolbar button or choosing
Show Design from the Window menu.
2.  Click on Image Collection tab and choose iPhoto in the pane.
3.  Use the pop-up menu to switch between albums. The program will display
thumbnails of your photos. This may take some time if your iPhoto library contains
many pictures.
4. Drag an image to the document.

To insert an image from a file on the disk:
1.  Choose Insert Image from the File menu, or press Cmd+Option+I.
2.  In the Open dialog, navigate to the graphic file you want to open and click the
Open button. Images in JPEG, PDF, EPS, GIF, PNG, TIFF and some other formats
can be used in the program.
3.  The image will be inserted into the center of the document.
If you need to insert multiple images from a single folder, the best way is to use
the Custom Folder tab on the Clipart panel.

To find and download an image from the Internet:
1.  Choose Search Images on Internet from the File menu.
2.  In the dialog, type the keywords that describe the image you need and click OK.
Mail Factory uses Google image search engine.
3.  Found images will be displayed in the Design window as downloaded.  Click on
the image you need to insert it into the document window.

To change properties of the selected images, use Inspector.

Editing Images

Mail Factory lets you edit images. The most image editing tools are accessible via the Inspector window.

Starting from Tiger Mac OS (version 10.4), you can use Core Image filters in the "Edit Image" window. To
access Core Image filters from Mail Factory you need to install the Image Tricks application.

You can apply blur, distortion and other effects to images. Filters are distributed into categories. Some filters
have parameters that can be varied, that can be numeric parameters and/or color.
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To apply a filter:
- Select an image in the document window.
- Double-click on it, or use the Edit button in Inspector. The "Edit Image" window will open.
- Select a filter from the list. Adjust filter parameters (if you need and if available for the selected filter).
- Click OK.

More information related to Core Image filters can be found on the Image Tricks Web page:
http://www.belightsoft.com/imagetricks/

Tint Image

To tint the selected image with the selected color, enable the Tint check box. Click on the color button
nearby to change the tint color (the Color panel will open). The Opacity slide bar changes opacity of the tint
color.

Mask Image

To get some interesting effects, you can apply a mask to an image.
Check the Mask Image check box in the Inspector and choose the mask pattern.

To select a picture as a pattern from a file click the “Browse” button.
To use a picture from the Clipart as a mask drag it into the box at the left of the browse button.



Mail Factory User’s Manual Working with Objects

BeLight Software, Ltd   www.belightsoft.com Working with Images 57

Crop Image

To crop an image, double click on it or select it and click on the “Edit” button in Inspector. The Edit Image
window will open. Use the Crop tool to select a part of image you need, then click OK.
Cropping is helpful when you want to use some part of a photo or other picture.

    

Image Rotation and Flipping

To rotate and flip a selected image, use the Rotate and Flip controls in the Inspector.

Opacity

To change transparency of an image, use the Opacity slider. Transparent images can be used as a
background for text or other images.

Tile Image

Tile Image creates multiple copies (1:1 or down-scaled) of the image in the rectangle which that image take.
This feature can be used for decoration of your envelope or label.
To tile image select it and choose Tile Image in the menu or tick "Tile" in Inspector. Use "Tile" slide bar to
adjust number of tiles and their size.
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Working with Smart Shapes

Smart Shapes can be used to decorate your labels and envelopes or for other
purposes.
To add a shape, open the Design window using the "Design" button on the toolbar
or through menu Window/Show Design. Drag and drop a shape on the label or
envelope or click on it.

Most shapes behave like ordinary images, they can be moved and resized. Other
operations on them are available through the Inspector window. Open it using
"Inspector" button on the toolbar or through “Window/Show Inspector” menu.

In the Inspector you can change attributes of the selected shape. The main
difference between shapes and images: shapes are special vector objects that
have more parameters to control.

Border Line

Border Line can be made visible/invisible by using  "Line" checkbox.
Use "Color" box to change Border Line color.
Adjust thickness of the line using "Thickness" control.

Color Filling

Color Filling can be made visible/invisible by using  "Fill" checkbox.
Use "Color" box to change Filling color.
Adjust opacity of the shape using "Opacity" control.

Image Rotation and Flipping

Inspector has controls to Rotate and Flip shapes.

Special Smart Shape Attributes

"Curve" and "Side Count" options can be applied to some shapes.
For example, 8-point Star can change number of rays - "Side Count" control and
angle of rays - "Curve" control.
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Chapter 10
Printing
Mail Factory allows you to print labels and envelopes on any inkjet or laser printer. The program also
supports label printers like DYMO LabelWriter®, Seiko (SLP-series) and Brother (QL-series) thermal printer.

Mail Factory can print more precisely on special label paper and on envelopes than ordinary text editors.
In order to get high quality in printing labels or envelopes, you need to design them using a template of
paper that will be used for printing.
To select a paper template use the Layouts dialog. More about the Layouts see in Chapter 5.

It’s also important, what kind of paper to use. Paper must be compatible with your printer.
More about this see on BeLight Software Web site.
http://www.belightsoft.com/products/companion/printers/labelprint.php

Using Mail Factory, you can print one label or envelope, many copies of them with a single delivery address
or with different delivery addresses at one printing task (Merge Printing mode).
You can print individual addresses and multiple addresses.

Print command (menu File/Print) is used for printing repeating addresses (e.g. when you need to print
several Return Labels with the same address on them). Merge Printing command (menu File/Merge
Printing) is used for printing labels/envelopes with automatically changing recipients' addresses on each
following label/envelope according to Print List. Addresses are automatically processed: their formats
change (according to the country), bulky addresses are resized, etc.

Start printing
Menu: File/Print
Shortcut: Cmd+P

Start merge printing
Menu: File/Merge Printing

When the Print window is already open, you can switch from one printing mode to another.
Printing on a label requires precise address location, therefore we recommend to calibrate your printer first.
The default printing settings can be changed in the program Preferences (“Mail Factory/ Preferences” menu,
Printing tab).
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Printer Calibration

If labels don't line up correctly on the label stock, you should calibrate your printer. Printer calibration
attempts to resolve this issue by adjusting the differences between what you see on the screen and what is
printed out.

To setup printer calibration:
1.  Choose “File/Calibrate Printer...” in the menu.
2.  Choose a printer from the pop-up menu.
3.  Insert a sheet of the label stock into your printer.
4.  Click the Print button. The calibration marks will be printed on the sheet.
Enter the values of the tick marks closest to the RIGHT side and BOTTOM side of the top-left label on the
sheet into the Horizontal and Vertical text boxes in the dialog.
You can enter positive and negative values depending on the label shift direction.
Horizontal: positive values will move your design to the right, negative – to the left.
Vertical: positive values will move your design to upward, negative – downward.
6.  Click the OK button when finished.

If after calibration you notice that the top rows of your labels print correctly, but the bottom ones get slightly
offset, then you'll need to change the scale value. In the calibration dialog, enter the value of the tick mark
closest to the top side of the bottom-right label into Scale field.

You can calibrate each printer you use - just select the printer and go through each of the above steps in the
Printer Calibration dialog.

Usually, 1-2 paper sheets is enough to calibrate printer.

After calibration, several labels in the middle of the paper sheet stay blank. You can use them later for
printing.
For example, if the 4th label is blank, set "Start from label" in the Print dialog equal to 4. According to this,
you will need to decrease the "Number of labels" value.

Calibration is not necessary when printing envelopes and for printing on label printers.

Note: Entering correction values does not affect the calibration table. The calibration rulers on the calibration sheet
always show the shift between printer and program null points, even after calibration.
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Sample

If your printed calibration table looks like the one on the
sample picture, enter “2” in HORIZONTAL and “–3” in
VERTICAL.
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Label Printer Calibration

To calibrate label printer:
1.  Choose “File/Calibrate Printer...” in the menu.
2.  Choose a printer from the pop-up menu.
3.  Click the Print button (paper must be already inserted into the printer). The calibration marks will be
printed on a label.

You should define the distance between zero of the calibration rulers and center of the label. For this, fold
the label in halves horisontally and vertically. The horizontal fold line will cross the vertical axis. Enter the
ruler's value at this point to the Vertical (Y) box of the calibration dialog. Do the same for Horizontal (X)
value.

4.  Click the OK button when finished.

Note: Entering correction values does not affect the position of the calibration rulers. They always show the shift
between printer and program null points, even after calibration.



Mail Factory User’s Manual Printing

BeLight Software, Ltd   www.belightsoft.com Label Printing 63

Label Printing

This subchapter is about printing settings and about printing labels with a single delivery address.

To print one label or many labels with the same address:
1. Click the Print button on the toolbar or choose Print from the File menu.

2. The print dialog will come up. In the dialog you can see the label preview as they will be positioned on the
printed sheet. The page size (Letter, A4, etc.) is set automatically according to the label paper template
you're using.

- Select the printer you would like to use in the Printer list at the top of the dialog (if you have more than one
printer).
- Enter the number of labels you would like to print in the appropriate field of the dialog.
To print all labels on the sheet, click the Down stepper button on the right of the "Number of labels" edit box.
- Enter the position where you would like the first label to be printed in Start from label field.

Marking: If you need the cut marks or label outlines to be printed, tick the Cut lines and Dotted marks boxes
respectively. This may be helpful if you're printing on regular paper, rather than special label paper, and
want to cut the labels afterwards.
Rules options are commonly used in Merge Printing to manage address appearance on the label. But they
also work for ordinary printing (e.g. to switch off Country field).

- Suppress Country Field hides the country field when the recipient is in the same country as the
sender.

- Address AutoResize enables/disables automatic resize of address fields. Used in Merge Printing
when you can’t make sure that all addresses from a print list find room on labels.

- Hide separating Commas hides commas between the address panel fields.
The default value of Rules can be set in the Preferences dialog.

- Print as Raster Image - send the document to the printer as a raster image, rather than vector.
Enable this option if you have problem printing your labels or envelopes - it makes printing slower, but solves
some printing problems. The default value can be set in the Preferences dialog.
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3. Click the Next button. System dialog with selected Copies&Pages option will come up for setting printer
options (such as print quality, etc).

4. Finally, choose the Print button.

When you print out your labels, they may not line up correctly on the label stock - then you will need to
calibrate your printer. For more information, see Chapter 9 "Printer Calibration".

To select printing mode use “Print for One Person” and “Merge Printing” radio buttons.
More about Merge Printing see in the “Merge Printing” subchapter.

You can edit your label in the Print window preview. This feature is most useful in the Merge Printing mode.
Usually such editing is used for slight corrections like text and image positioning and for text modifications.
To edit a label document before printing, click on the Editing Mode button and select a label to edit. Or
double click on a label. When finished, click the Close editor button. Unlike editing in the main program
window not all features will be available. The result of editing in the Print window will not be applied to the
original document.

Printing a Portion of Labels on a Sheet

You can print some portion of labels on a sheet and later continue with the first blank.
For instance, at the first time you need to print 12 labels on a 30-label sheet. Enter 12 in “Number of labels”
and 1 in “Start from label” (set by default). If at the next time you need to print 7 labels, enter 7 in “Number
of labels” and 13 in “Start from label”.

Don’t forget inserting a paper into the printer always with the same side. Usually manufacturers mark one
side to be inserted.

Note: label paper manufacturers don’t recommend printing on their paper more than once. But usually it doesn’t
cause a problem if you print twice on laser printer and several times on inkjet one. Don’t use label paper repeatedly if
there are defects on it (it is wrinkled, has unstuck labels, etc.).
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Envelope Printing

Printing envelopes has its own specifics. That mostly concerns envelope orientation and feeding, which may
differ from printer to printer.

Some printers can’t print close to the paper sheet or envelope edges and that often cuts the return address.
To resolve this problem, you can either move the address block further from the edges, or use the rotate
buttons in the Print dialog - the mailing address and barcode are normally not too close to the edges, so if
the envelope is rotated it may solve the problem.

Usually envelopes are inserted in printers in the same way as plain paper. You insert them instead of Letter
or A4 sheets. Almost all printers have built-in support for most popular envelope sizes. Some even have
special envelope trays for feeding envelopes. Mail Factory allows you to choose between feeding from plain
paper tray and envelope tray.
Feeding envelopes from plain paper tray is selected as default. In this case you can control how to feed and
position the envelope. If your printer has an envelope tray and you want to feed envelopes from it, enable
"Load from envelope tray" option in the Print dialog. But your printer must support the envelope you want to
print on.

To print envelopes:
1. Click the Print button on the toolbar or choose Print from the File menu.

2. The print dialog will come up. In the dialog you can see a preview of the envelope and its position
relatively to a printed page (at the right, centered, or at the left). How to set this option depends on your
printer. Usually you need to choose the middle button for a laser printer and the left button for ink-jet
printer.

- Select a printer you would like to use in the Printer list at the top of the dialog.
- Use Load from envelope tray option, if you use a special tray and the printer supports your envelope size.
- Enter the number of envelopes you would like printed in the appropriate field of the dialog.



Mail Factory User’s Manual Printing

BeLight Software, Ltd   www.belightsoft.com Envelope Printing 66

Rules options are generally needed in Merge Printing to manage address appearance on the envelope. But
they also work for ordinary printing (e.g. to switch off Country field).

- Suppress Country Field hides the country field when the recipient is in the same country as the
sender.

- Address AutoResize enables/disables automatic resize of address fields. Used in Merge Printing
when you can’t make sure that all address from a print list find room on envelopes.

- Hide separating Commas hides commas between the address panel fields.
The default value of Rules can be set in the Preferences dialog.

Print as Raster Image - send the document to the printer as a raster, rather than vector image. Enable this
option if you have problem printing your labels or envelopes - it makes printing slower, but solves some
printing problems. The default value can be set in the Preferences dialog.

3. Click the Next button. System dialog with selected Copies&Pages option will come up for setting printer
options (such as print quality, etc).

4. Finally, click the Print button.

You can edit your envelope in the Print window preview. This
feature is most useful in the Merge Printing mode. Usually such
editing is used for slight corrections like text and image
positioning and for text modification.
To edit the envelope document before printing, click on the
Editing Mode. Or double click on an envelope.

When finished, click the Close Editor button. Unlike editing in
the main program window not all features will be available. The
result of editing in the Print window will not be applied to the
original document.

When feeding an envelope, pay attention to the orientation of
the flap, so that the address is not printed upside down. The top
edge of the envelope that you see in preview window is the
envelope edge that has to be inserted into your printer's tray.

Here are the most typical Paper Feed settings.

Laser printers InkJet printers

If your printer has special tray for envelopes, enable "Load from envelope tray" option in the Print dialog.

Note: Refer to your printer User's Guide for details.
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Merge Printing

For instance, you need to send a number of envelopes with different delivery addresses. Normally this would
mean you have to change a recipient address before printing every next envelope.

Merge Printing is a way to print a number of different delivery addresses at one print task. They will be taken
from a print list.

You will need to design an envelope (or label) and compose a list of recipients (print list). The program will
automatically take another recipient address from your list when every next envelope or label is printed.

To print multiple addresses:
1. Once you finished designing your label or envelope, click Merge Printing button on the toolbar (or choose
File/Merge Printing).
Or click the Merge Printing radio button in print dialog.

2. Print dialog will appear again. In preview area you will see how your envelopes or labels look like with the
selected addresses. Make sure that all settings, such as printer, number of copies, etc. are correct. For more
details on printing settings see previous section about ordinary printing.
- Select necessary print list from Merge Printing pop-up menu. If you don't have any print list or want to
change the existing list, use Edit List item from the pop-up menu. Print List editing dialog will appear.
In this dialog you can create one or several lists of people whose addresses you wish to print. (See details
about print lists in the Chapter 10.) When finished, click OK.
- Options for automatic address processing are available from Rules section. Their default values can be
altered in the Preferences dialog.

- Suppress Country Field option is used for hiding country field, when correspondence takes place
within one country (e.g. From Canada to Canada). Such circumstances are tracked down and country field is
automatically hidden.
If there is only one address (when a label is printed), the second country address is taken from Default
Address Format settings in the Preferences dialog.

- Address AutoResize option reduces address panel print size, in case if the address is out of
label/envelope borders.

- Hide Separating Commas option was designed to remove commas between fields (between city and
ZIP code, company and department).
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Any label or envelope can be edited prior printing directly from Print dialog. This is very convenient if you
need to move address panel on some labels, or some person's data require slight correction. You just need
to enter label editing mode and make the corrections.
Double click on a label/envelope to start editing (or click on Editing Mode button and select a label with the
mouse). Preview window will display the selected document, in which you will be able to make necessary
changes. To exit editing mode, click Close Editor button.
Note, if there are many changes, you would better change initial document or database.

3. Click Next button. System dialog with selected Copies&Pages option will come up for setting printer
options (such as print quality, etc).

4. Finally, click Print button.

When you start merge printing the default number of labels or envelopes to print is equal to the number of
people in the list.

Sometimes it can be necessary to have envelopes or labels printed in alphabetical order (of personal or
company names). For this, your print list can be sorted before printing. To sort it, open the “Print List” tab of
the Contacts window, click “Edit Print List” and select a sorting rule. See more details in Chapter 10:
Embedded databases.

Merge Printing Tip:
For example, you need to print on labels addresses of 10 people by 3 copies of each. And you have 30-label paper.
It’s enough for your task.
Create 10-person print list and start merge printing. Set 30 in the “Number of labels”: 10 labels by 3 copies.
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Post Card Printing

Predefined postcard layouts in the program can contain one or more postcards per page.
Depending on this the print dialog will have different set of controls.

If you have selected one-postcard template the Print dialog will be similar to the envelope's one.

When you have several postcards per page (usually 2 or 4), you will be able to set the postcard position from
which to start printing (see details in the "Label Printing" subchapter).

More tips about postcard printing see in Chapter 8 "Postcard Document Creation".
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Chapter 11
Embedded Databases

Using the Contacts Window

Mail Factory can take addresses and other personal information from different external sources. The access
to them is available from Contacts window (menu Window/Show Contacts). When you choose the person
from this list, his details are automatically displayed in the Address Panels and Text Fields available in the
document. The "From" tab is connected to the Sender Database. "To" and "Print List" tabs manage the
recipient's details.

"From" tab (Sender List)

This is the list of return addresses. To edit the list, click the Edit List button.

"To" tab (Recipient List)

Use persons' list from this tab to print a unique recipient's address on one or
several labels or envelopes.
The Recipient list consists of personal data that was taken from one of external
sources or the embedded My Recipients database.
The external databases can be: Apple Address Book (used by default), MS
Entourage, Eudora, Now Contact, vCard Data Source, Text File, MS Excel,
FileMaker Pro. To find a name within the current list, type the name in Search field
below.
If an address source like Text File is selected and you modified it by another
program, Mail Factory can reload this text file after clicking the Update button.

"Print List" tab

Print List is a list of recipients - a useful feature for batch printing multiple labels and envelopes. Find more
at “Merge Printing” and “Print List Database” subchapters.

Note: You can edit the personal information right in the Contacts window by double-clicking on the person's name
(the exception is the data from external applications, such as Apple Address Book, etc.).
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Sender Database

Sender Database is one of the embedded databases.
Its main purpose is to keep sender's addresses. The number of senders is not limited to one.
This is helpful if the program is used by several people, when you need to print work and home addresses or
in other cases.

Personal records can be imported from external data sources like Address Book and other. Sender Database
can store personal data from several such sources.
Alternatively, you can add a blank personal record and type contact data into corresponding fields. Imported
data can be also modified.

Mail Factory saves Sender Database to have it available after the next launch.

Data from Sender database can be used to fill corresponding fields in "From" address panels.

You can access the Sender database through the Contacts window and at the third step of Assistant (prior to
designing).
When you click the “Edit List” button, the following dialog will open.

There are three panels in the database window:
Address Source - list of persons from the selected address source. Data of some address sources (like
Address Book) is divided into several groups. You can select such group in the Group pop-up menu.
You can search persons in this list using the search tool.
If your external database was modified, you can force the program to reload data from it using the Update
button.
Sender - list of persons whose data can be used for “From” (sender) address panels. This list is represented
by the “From” tab of the Contacts window. You can add, delete, and sort names in this list. Names in this list
can be edited via the “Personal Info” panel.
Names in the Sender list are sorted according to a sorting rule selected below.
The "Plus" button adds a new blank personal record and "Minus" button removes the selected record.
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Personal Info panel shows information of the person selected in the Sender list. All fields are available for
modifying.

Working with the Sender panel

Adding a person from Contacts list of Address Source: drag and drop a name to the Sender list or select a
name in Contacts list and click "Arrow" button. Double click on a person in Address Source also adds this
person to the Sender list.
Adding a new person: click the "Plus" button to add a blank personal record. "No Name" will be added to the
list. All fields in the Personal Info panel will be blank (you will see names of these fields in gray). Enter the
required information there.
Deleting a person: to delete a name from list, select it and click "Minus" button.
Sorting persons: names in Sender list can be sorted by different criteria. Select criterion in Sort pop-up
menu. "Last Name" is set by default.

Working with the Personal Info panel

This panel allows to preview and modify personal data such as name,
address, company name, telephone number and other. Personal data
fields on Personal Info panel can be edited. To select a field, click on it.
To switch between fields use Tab and Shift+Tab keys. Some fields, such
as address, phone and fax can be set for different locations. This is
useful when you have person's work and home addresses. Or when some
company has a headquarter and branches in different locations and you
need to keep all their addresses. To switch between addresses select
Home, Work or Other tab.
Empty fields keep their names in gray.
In the bottom of Personal Info panel are custom fields - use them for any
additional textual or numeric information.
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My Recipients Database

“My Recipients” is one of the embedded databases.
This database can be used if you need to merge records from several external databases into one place.
Also, if you don’t intend using any external database, save your contact data in “My Recipients”.

Personal records can be imported from external databases like Address Book and other. “My Recipients”
database can store personal data from several such sources.
Alternatively, you can add a blank personal record and type contact data into corresponding fields. Imported
data can be also modified.

The data from “My Recipients” database can be used to fill corresponding fields in "To" address panels.

You can access "My Recipients" database through the pop-up menu in the Contacts window, at the third step
of Assistant and via Window/Contacts/Recipients menu.

Contact data from "My Recipients" can be easily copied to the Sender and Print List databases because it is
accessible there as a source.

Using the “My Recipients” database is very similar to Sender Database. See details about using this
database in the previous subchapter.
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Print List Database

The Print List database stores recipient addresses. It can be used as “My Recipients” for printing one or
several labels and envelopes with the same recipient address.

But its main purpose is printing a series of envelopes or labels with different delivery addresses in the Merge
Printing mode.
For example, invitations to a presentation. You will have to print dozens of envelopes with unique recipient
address on each. It is too boring and takes too much time to print each envelope manually. Merge printing
will save you from dull work.

In Mail Factory you can create a print list for batch printing multiple labels and envelopes. When printing
multiple addresses, the address information in the address panel is substituted with addresses from the
print list. You have to design only one label/envelope as a template.
For more details about Merge Printing see Chapter 9.

You can access Print List Database from different places.
• Through the Contacts window (menu: Window/Contacts/Print Lists). This way is the most convenient

during design process.
• At the third step of the Assistant.
• In the Print dialog when "Merge Printing" radio button is checked.

Contact data from the Print List database is associated with "To" address panel.

If you regularly conduct presentations or invite people to your birthday, you deal with more or less constant
groups of people. Mail Factory lets you create and save a separate print list for each group. Before printing,
select corresponding print list in Print List pop-up menu.
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Working with Print List Database

To open the Print List database, click the “Edit Print List” button on the Print List tab of the Contacts
window. The following dialog will open.

The Address Source panel represents external sources of contact data and “My Recipients” (embedded
database).
Below the Source pop-up menu you can see the Contacts list representing names from the selected address
source. These names can be added to a print list.
To find a name within the Contacts list, use the Search tool.

The middle part of the database window contains list of print lists (at the top) and list of persons from the
selected Print List (in the center).

The Personal Info panel contains personal data such as name, address, company name, telephone and other
of the selected person. Personal data fields on Personal Info panel can be edited. To select a field click on it.
To switch between fields use Tab and Shift+Tab keys. Some fields, such as address, phone, fax can be set
for different locations. This is useful when you have person's work and home addresses. To switch between
addresses select "Home", "Work" or "Other" tab.
Empty data fields keep their names in gray.
At the bottom of the  Personal Info panel there are custom fields - use them for any additional textual or
numeric information.
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Creating a new print list via import

1. Click on the "Plus" button to add a void print list. You can change its name (for this, click on the name
and type in a new one).

2. Choose a source address database. If its data is divided into groups, select a group. To get the latest data
from an external database, click the Update button.
The Contacts list will show the person’s list of the selected source.

3. Fill your print list with persons from a source database. To do this, drag a person into the print list or
double click on it. To add several persons, highlight them and drag into print list (or click the “Arrow”
button).
To highlight several persons using the mouse, keep the Cmd key pressed.
To highlight a range, highlight the first person, press Shift and highlight the last one.
To highlight all, press Cmd+A.

4. If you need to add or modify personal data, select a person in a print list and click on a data field of the
Personal Info panel.

Manual creation of a new print list

1. Click on the "Plus" button to add a void print list. You can change its name (for this click on the name and
type in a new one).

2. Click on the "Plus" button below the Persons list to add a void personal record.
Name "No Name" will be added to the list. It will change, when you enter First and/or Last name.
Until you fill fields on the Personal Info panel, data fields will show their names in gray.

3. Enter the required information into data fields of the Personal Info panel.
Repeat steps 2 and 3 to add as many persons as you need.

To remove a selected person from a print list, click "Minus" button.

Names in your print list can be sorted. Select required sort order in the Sort pop-up menu.
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Chapter 12
Using Contact Information From
External Databases and Contact
Managers

General Information

Mail Factory can use addresses stored in Apple Address Book, Microsoft Entourage, Microsoft Excel, Now
Contact, Eudora and FileMaker Pro. If you have any of these programs installed on your computer, you will
be able to select them as the source of your contacts. Besides, Mail Factory can take addresses from tab-
delimited text files and vCard files because many programs can save data in these formats.

The person's details are displayed in the Contacts window. They can be also used for filling out the
embedded databases of Senders, Recipients and Print Lists.

Importing from External Contact Managers

Mail Factory uses AppleScript to pull information from external contact managers
(except Apple Address Book, to which the program has direct access).  When you
select, for instance, Entourage or Now Contact as the source in the Contacts
window for the first time, this program will be launched so that Mail Factory can
access information stored in it. This may take a while, until Mail Factory imports
the addresses into its internal database. The time, required for import, depends on
the size of your database and performance of your computer.

If Mail Factory can't launch the external program or calls the wrong version of the
required program, please check the path settings in Preferences dialog, Address
Panel tab.

The next time you select Entourage or Now Contact from the Source pop-up menu, the Contacts window will
display the list of the previously imported contacts. You may update the list by clicking the Update button -
Mail Factory will import the contacts from the corresponding contact manager.

Note: To use Mail Factory with Now Contact, the Contact File must be the primary file. You can make a contact file
"primary" when you open the file with Now Contact (enable the Make this file primary box in the Open dialog).
The primary file is the file that opens automatically when you launch Now Contact.

Note: If you need to import the data from another contact manager, which is not directly supported by Mail Factory -
it isn't a problem. Your contact manager program probably has the option to store contacts in the form of vCard or
tab-delimited text files. Read below how to read the information from such files.
Use this method in case you meet a problem with import from a supported data source.
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Importing Data from Text and Microsoft Excel Files

A powerful feature of Mail Factory is its ability to siphon information from tab- and comma-delimited text
files, as well as from Excel files. A tab-delimited file is a text file that contains fields and records. Tab-
delimited files can be created by most applications - contact managers.

“Tab-delimited” means data fields in such file are separated by tab character.
One person’s data takes one row like this:

[First Name][tab][Last Name][tab][Title][tab][Suffix][tab][Nickname][tab][Company][tab][Job][tab][Title] …

The kind of contact data and order of fields depends on the application that created such text file. Lines are
ended with the line break symbol. After it the data of the next person goes. Tab- or comma-delimited text file
can be opened in a text editor.

The main task of import process is to associate external data with predefined internal data fields. For
example, street name must get into the Street field, country name into the Country field and so on.

Before you start importing, you should know that not only tab character can be used as delimiter, but also
comma and other. Depending on a program which created a text file, it can start with a header. Also text files
can use different encoding systems.

To import contacts from a text file or an Excel file:
1. Call the Contacts window (menu Window/Show Contacts).

2. Choose "To" tab; in the Source pop-up menu choose Text File if importing from a text file, or MS Excel to
import an Excel workbook.

3. If it's your first import, the File Open dialog will come up. Navigate to the needed file on your computer,
select it and click OK.  If you imported contacts from a file before, you'll see the results of the last import in
the list. To choose another file or reload current, click the Update button.

4. The Import dialog will come up. In the first column of the dialog, you'll see the first row of the imported
text or Excel file. If the first row in the imported file is header, check the “First Row is Header” box below.
The first number below the Next button is the number of
person whose data is shown in the window. The second
number is quantity of persons to import.

5. Now you need to associate the fields in your source file
with the fields in Mail Factory address panel. Look at the
fields in the Contact Data column, and, opposite the fields
you need imported, click on the corresponding cell in the
Map To column. A pop-up list will appear. In the list,
choose the appropriate field name. For instance, if the
first cell in Contact Data column contains "Ralf", choose
"First Name" in the corresponding Map To cell.
You mustn't map all fields. For instance, if your tab-
delimited file contains phone numbers, and you don't need
them in Mail Factory, just leave the corresponding cells in
the Map To column blank.

Use Next and Previous buttons to move from one person to another and see if mapping was done correctly.

6. Once you're through, click the Import button.

Note:
• If the file has other kinds of delimiters rather than tab ones, you need to choose the required sign in the pop-up
menu of Delimiters. If you see only one data line when a lot is expected, try to select another delimiter.
• You can select correct encoding for the text files with special symbols (for example German contacts with umlauts).
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Mail Factory will import the contacts from the text or Excel file, and they will appear in the Contacts window.
The imported contacts will be stored in Mail Factory until you import them from a new file. To import data
from another file, just click on the Update button at the bottom of the Contacts window and repeat the above
steps.

Note: use plain text format files for importing.
If you have a text file in RTF (Rich Text Format) or in any other, open this file with text editor and save it as plain text
for further use.
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Importing Addresses from vCard Files

Mail Factory supports the vCard format - a popular format for exchanging contacts, used by many contact
managers, handheld devices and mobile phones. Both individual and group vCards are supported.

In the Contacts window ("To" tab), select vCard Data Source from the Source pop-up menu. If you haven't
imported any vCards yet, the file dialog will come up, allowing you to navigate to the vCard file on your
computer. Choose the vCard file, click OK and the contacts from the vCard file will display in the window. If
you already imported a vCard before, you will see its contents in the Contacts window.  To choose another
vCard file, click the Update button and choose the file in the file dialog.

Importing Data from a FileMaker Pro Database

Apart from importing information from tab- and comma-delimited text files, Mail Factory can pull data
directly from FileMaker database files. It uses AppleScript to communicate to FileMaker Pro, so FileMaker
Pro must be installed on your computer.

To import contacts from a FileMaker file:
1. Call the Contacts window (menu Window/Show Contacts).

2. Choose "To" tab; in the Source pop-up menu, choose FileMaker Pro.

3. If it's your first import, the File Open dialog will come up. Navigate to the needed FileMaker file on your
computer, select it and click OK.  If you imported contacts from a file before, you'll see the results of the last
import in the list. To choose another file, click the Update button.

4. FileMaker Pro will be launched and activated.

5. Switch back to Mail Factory. The Import dialog will come up. In the first column of the dialog, you'll see
the first record of the FileMaker Pro file.

6. Now you need to associate the fields in your source file with the fields in Mail Factory address panel. Look
at the fields in the Contact Data column, and, opposite the fields you need imported, click on the
corresponding cell in the Map To column. A pop-up list will appear. In the list, choose the appropriate field
name. For instance, if the first cell in Contact Data column contains "Ralf", choose "First Name" in the
corresponding Map To cell.

7. You mustn’t map each and every field. For instance, if your FileMaker Pro database contains phone
numbers, and you don't need them in Mail Factory, just leave the corresponding cells in the Map To column
blank.

8. Once you're through, click the Import button.

Mail Factory will import the contacts from the FileMaker Pro file, and they will appear in the Contacts
window. The imported contacts will be stored in Mail Factory until you import them from a new file. To
import data from another file, just click on the Update button at the bottom of the Contacts window and
repeat the above steps.
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Chapter 13
The Preferences Dialog.
Default Program Settings
The Preferences

Mail Factory has settings that are applied by default every time
you run the application. You can control progam behaviour
changing the default settings in the Preferences dialog.

Open the Preferences dialog
Menu:     Mail Factory/Preferences
Shortcut: Cmd+","

This dialog controls application-wide settings.

The General tab

Open on Start-Up - here you can specify what to do when the
program is launched - open the Assistant, create a blank Label
document or create a blank Envelope document.
Snap - enables or disables the Snap mode - the mode, when
objects are aligned to other objects when you carry them with the
mouse. You can also temporarily disable the Snap mode if you
press and hold the Cmd key when you move the objects.
Font - sets default font for new texts.

The Address Panel tab

Default address format - allows you to choose the default
formatting for address panels that will be applied when the
program can't set the address format automatically.
Capitalize address panel automatically - transforms the address
to all caps. The default setting is off.
Make address format country-sensitive - if this option is
enabled, Mail Factory will automatically format the address
according to the postal standards of the country in the address.
If the country is not specified, the address will be formatted
according to the Default Country setting.
Set street field in a line – convert two-line street addresses into
one-line.

The Printing tab

The following settings represent default values of Print dialog
settings.
Print document as raster image - send the document to the printer
as a raster image, rather than vector. Enable this option if you have
problems with printing your documents - it makes printing slower,
but more accurate.
Suppress Country Field - enable this option if your correspondence
is mostly within your own country, and you don't need the country
in the address.
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Hide Separating Commas - hides commas within address panels (if there were any). The default setting is
off.
Mail Factory automatically inserts commas in addresses of specified countries  (for instance, between City
and State for USA).

Address AutoResize - automatically reduces the address panel's size if it is out of the label or envelope
edges.

The Address Importing tab

Here the default location of the data source applications is
selected. Mail Factory uses Apple Script for data conversion.
Setting the exact path to the application helps to choose the
correct application if there are several of them or they are
incorrectly registered in the system.
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APPENDIX A
Postal Guidelines
Postal service in the USA and some other countries uses special equipment that sorts mail automatically and
helps to deliver mail faster and more accurately (and sometimes at less cost). To qualify for automated
processing, your mailpiece must be prepared properly.

The Postal Guidelines mark the recommended zones for the Return and Delivery addresses. Use
"Show/Hide Postal Guidelines" from the View menu to toggle the guidelines on / off. Placing your
addresses within these zones, as well as meeting other requirements provided below, helps to make your
mailpieces automation-compatible. Automated equipment can process mail more efficiently, allowing the
Postal Service to maintain lower rates for those pieces.

To be automation-compatible, your mailpiece should meet the following requirements:
• Dimensions for letter-size mail should range from 3 1/2" x 5" to 6 1/8" x 11 1/2".
• Use ZIP+4 code when applicable. Make sure the code is correct!
• Enable postal barcodes when possible (works for US, UK and Canadian addresses).
• Position the addresses within the guideline's zones.
• Recommended font size for delivery address is from 8 to 18 points.
• Avoid using unusual fonts/styles for addresses. Plain Arial font will work in most cases.

Mail Factory lets you prepare your labels and envelopes in accordance with USPS postal guidelines (which
should work for most other countries, too).

For detailed information about designing automation-compatible mail and the benefits it gives you, use this
link (refers to United States Postal Service):
http://pe.usps.gov/text/Pub25/Pub25ch1.htm#Financial%20Savings

See also the ”Postal Resources in the Internet” article on our Web site:
http://www.belightsoft.com/products/resources/postal.php
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APPENDIX B
Menus
The "Mail Factory" Menu

About Mail Factory Displays the dialog with information about the program.
License... Gives access to the registration information.
Check for Updates Checks for the latest updates on the Internet:

http://www.belightsoft.com/mailfactory/update/
Preferences (Cmd+",") Brings up the program preferences dialog.
Quit (Cmd+Q) Exits the application.

The "File" Menu

New Label (Cmd+N) Creates a new blank label document.
New Envelope (Cmd+Option+N) Creates a new blank envelope document.
New Postcard (Cmd+Ctrl+N) Creates a new blank postcard document.
New from Assistant... (Cmd+Shift+N) Creates a new document with the help of the Assistant.
Open... (Cmd+O) Opens an existing document.
Open Recent > Contains the list of the documents you last worked with.
Close (Cmd+W) Closes the active document window.
Save (Cmd+S) Saves the active document.
Save As... (Cmd+Shift+S) Saves the active document with a new name.
Export... (Cmd+Option+E) Saves the active document as a graphics file (PDF or TIFF

format).
Insert Image... (Cmd+Option+I) Inserts an image from a file into the active document.
Search Images on the Internet... Opens a dialog where you can enter keywords to search images

on the Web using Google image search.
Calibrate Printer... Displays printer calibration dialog where you can calibrate the

printer for more precise printing.
Page Setup... (Cmd+Shift+P) Presents the standard Mac OS X dialog for changing the size,

orientation and other parameters of the active page.
Merge Printing... Brings up the Mail Factory print dialog for "Merge Printing"

process.
Print... (Cmd+P) Brings up the Mail Factory print dialog. See "Printing Labels

and Envelopes" for details.

The "Edit" Menu

Undo (Cmd+Z) Reverses the last operation you performed.
Redo (Cmd+Shift+Z) Reverses the last Undo operation.
Cut (Cmd+X) Removes the selected objects or text and places the selection

onto the Clipboard.
Copy (Cmd+C) Copies the selected objects or text onto the Clipboard.
Paste (Cmd+V) Pastes the content of the Clipboard into the document.
Paste as Address (Cmd+Option+V) Pastes address from the Clipboard and automatically defines

address fields.

Duplicate (Cmd+D) Duplicates the selected objects.
Delete (Del) Removes the selected objects.
Group (Cmd+G) Transforms the selected Address panel to separated text fields.

See "Group and Ungroup Commands" for details.
Ungroup (Cmd+Shift+G) Creates a Custom Template Address panel from separated text

fields. See "Group and Ungroup Commands" for details.
Select All (Cmd+A) Selects all objects in the document.
Edit Image Opens the Edit Image dialog. See "Working with Images" for

details.
Tile Image Creates a tiled image. See "Working with Images" for details.
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Insert Sender Address Inserts the panel for the return address.
Insert Recipient Address Inserts the panel for the destination address.

The "View" Menu

Zoom In (Cmd+Option+"=") Enlarges the current view.
Zoom Out (Cmd+Option+"-") Zooms out the current view.
Actual Size Displays the document at its actual size (100%).
Address Panels Opens the "Address Panels" tab of the Design window. See

"Design Window" for details.
Address Fields Opens the "Address Fields" tab of the Design window. See

"Design Window" for details.
Clipart Collection Opens the "Clipart Collection" tab of the Design window. See

"Design Window" for details.
Smart Shapes Opens the " Smart Shapes" tab of the Design window. See

"Design Window" for details.
iPhoto Library Opens the "iPhoto Library" tab of the Design window. See

"Design Window" for details.
Custom Folder Opens the "Custom Folder" tab of the Design window with

image clipart from the custom folder. See "Design Window" for
details.

Handling Labels Opens the "Handling Labels" tab of the Design window. See
"Design Window" for details.

Show/Hide FIM-A Shows or hides the FIM (Facing Identification Mark) on the
envelope.

Show/Hide Postal Guidelines Shows or hides the lines that mark valid zones for addresses.

The "Format" Menu

Font->Show/Hide Fonts (Cmd+T) Displays Fonts dialog.
Font->Bold (Cmd+B)
Font->Italic (Cmd+I)
Font->Underline (Cmd+U)

Modifies properties of the selected text.

Font->Bigger (Cmd+"+")
Font->Smaller (Cmd+"-")

Increases/decreases the size of the selected text.

Font->Kern
Font->Ligature
Font->Baseline

Modifies properties of the selected text.

Text->Align Left (Cmd+{)
Text->Center
Text->Align Right (Cmd+})

Aligns text to the left, right or center.

Bring Forward (Cmd+Option+F)
Bring to Front (Cmd+Shift+F)
Send Backward (Cmd+Option+B)
Send to Back (Cmd+Shift+B)

Displays the selected objects above or behind all other objects.

Align Left Edges Aligns the left edges of the selected objects.
Align Centers Aligns the centers of the selected objects.
Align Right Edges Aligns the right edges of the selected objects.
Move to Center (Horizontally) Moves selected objects horizontally to the center.
Move to Center (Vertically) Moves selected objects vertically to the center.
Address Template -> ... List of address templates. See Address Templates in "Design

Window" for details.
Address Template -> Edit... Opens the "Address Panel Format" dialog. See "The Address

Panel Format Dialog" for details.
Country Allows to choose a country-specific address format for the

selected address panel.
Preferred Address Lets you choose which of the person's addresses to use (for

instance, "home" or "work").
Refers To Lets you choose to whom the selected address panel refers:

Sender or Recipient.
Customize Address Panel Opens a dialog where you can set custom formatting for the

address panel.
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address panel.
Change Layout... Opens a dialog where you can set layout for the selected

address panel.  See "The Layouts Dialog" for details.

The "Window" Menu

Close Window (Cmd+W) Closes the currently active window.
Minimize (Cmd+M) Minimizes the currently active window.
Bring All to Front Moves all application windows in front of the windows of other

active applications.
Show/Hide Inspector Displays or hides the Inspector window.
Show/Hide Design Displays or hides the Design window.
Contacts->Show/Hide Displays or hides the Contacts window.
Contacts->Senders Displays the Contacts window with open "From" tab.
Contacts->Recipients Displays the Contacts window with open "To" tab.
Contacts->Local Recipients Displays the Contacts window with open "To" tab where My

Recipients source is selected.
Contacts->Print Lists Displays the Contacts window with open "Print List" tab.
Show/Hide Colors (Cmd+Shift+C) Displays or hides the system Colors window.
Show/Hide Fonts (Cmd+T) Displays or hides the system Fonts window.

The "Help" Menu

Mail Factory Help (Cmd+?) Opens Help documentation, delivered with the application.
BeLight Software Web Site Goes to the Mail Factory Web page.
Useful Online resources Useful resources on BeLight Software Web Site connected with

Mail Factory.
About Postal Guidelines Displays information about correct mailpiece addressing and

design requirements.
Send Feedback Lets you send your feedback to the developers by e-mail.
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APPENDIX C
Shortcuts
Working with Documents

Cmd+N Create a new blank label.
Cmd+Option+N Create a new blank envelope.
Cmd+Ctrl+N Create a new blank postcard.
Cmd+Shift+N Create a new label or envelope by using the Assistant.
Cmd+O Open an existing document.
Cmd+S Save the active document.
Cmd+Shift+S Save the active document under a new filename.
Cmd+Option+E Export the document to a PDF or TIFF file.
Cmd+Option+I Insert an image from a graphic file.
Cmd+Q Quit Mail Factory.
Cmd+Shift+P Call the Mac OS X Page Setup dialog for adjusting the size,

orientation and other properties of the printed page.
Cmd+P Print the document.

Working with Objects

Cmd+Z Undo the last operation.
Cmd+Shift+Z Redo the last operation.
Cmd+X Cut the selected objects to the Clipboard.
Cmd+C Copy the selected objects to the Clipboard.
Cmd+V Paste the content from the Clipboard into the document.
Cmd+D Duplicate the selected objects.
Del Delete the selected objects.
Cmd+A Select all the objects in the document.
Cmd+Shift+A Show/hide the delivery address.
Cmd+Option+A Show/hide the return address.
Cmd+Shift+F Bring to Front.
Cmd+Option+F Bring Forward.
Cmd+Option+B Send Backward.
Cmd+Shift+B Send to Back.
Arrows Move the selected objects.

Working with Windows and Dialogs

Cmd+"=" Zoom In.
Cmd+"-" Zoom Out.
Cmd+M Minimize the active window.
Cmd+W Close the active document window.
Cmd+"," Call the application Preferences dialog.
Cmd+Shift+I Show/hide the Inspector window.
Cmd+Shift+D Show/hide the Design window.
Cmd+Shift+C Display/hide color properties dialog.
Cmd+T Display/hide font properties dialog.

Working with Text

Cmd+B Make text Bold.
Cmd+I Make text Italic.
Cmd+U Underline text.
Cmd+Alt+"=" Increase font size.
Cmd+Alt+"-" Decrease font size.
Cmd+Shift+C Copy style of the selected object to the Clipboard.
Cmd+Shift+V Assign the selected object style from the Clipboard.
Cmd+{ Align left.
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Cmd+} Align right.
Return Inserts a line break in a text field.
Enter Finish editing.

Working with the Mouse

Hold down Shift when working with
handles -

Invert proportional resize to unproportional, and vice versa.

Cmd+Mouse Toggle the snap object mode on/off.

Option+Mouse Duplicate objects.
Shift+click Select/Deselect object without changing other objects' properties.
Double click on an image Open an image in the Edit Image window.

Other

Cmd+? Call Online Help system, supplied with the software.
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APPENDIX D
Usage Tips

How to add "Attn.", "Mr. & Mrs." or other text into an address panel.

“Attn.” field
Mail Factory has standard address panel “Company+Attention” with the “Attn.” field.
See below how to create a custom address panel template.

“Mr. & Mrs.” field
You can add “Mr. & Mrs.” into standard “Family” address panel. Initially this panel
contains “The” before the ”Last” field.
You need to replace “To” with “Mr. & Mrs.” and remove “Family”. For this, click on "To",
the program will switch to the editing mode. Type “Mr. & Mrs.” into the field.

How to add a text field to an address panel template
The most simple method uses Ungroup and Group operations.
Use this method if you need to add "Attn.", "Mr. & Mrs.", “Dr.” or any other text data into a standard or
custom address panel.

Step 1
Add an address panel to a label or envelope. To do this, click the
"Address Panel" toolbar button.
Switch to a standard template that mostly satisfies your needs. For this,
click on the right side of address panel tag (where the template name
"Name+Company" or other is).

Step 2
Drag and drop the “Simple Text” field from the Design window into your
document. Or click on the “A” toolbar button and click on the document.
The “Text Data” field will appear, you can fill it now or later.

Select the address panel, call the context menu and choose Ungroup.
Place an added text field near other fields of ungrouped panel. At this
moment you can remove needless fields and rearrange the rest.

Step 3
Select all fields that will be included in a new address panel, bring up the
context menu and choose Group.
A new address panel is ready. Type in the text.

Step 4
Added text fields aren’t connected to any personal data so once filled they won’t change at Merge Printing.
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Problem with import from Microsoft Entourage
(nothing was imported)

Mail Factory launches Entourage and uses Apple Script to import.
Entourage has virus protection. When some program tries to access contacts database, Entourage asks your
permission.
Possibly, in your case, the protection is activated. It blocks the script, opens a message window and waits
you click OK or Cancel.

Maybe you didn't pay attention to this.
Mail Factory attempts for some time to get data and then stops trying to import.
To allow importing you need to switch to Entourage and click OK.

To allow importing for future, uncheck "Warn before allowing an external application to access the address
book" in Entourage preferences (Entourage/Preferences menu, Security section).

Note: In some cases Entourage can show other messages. You should react to them in order to let Mail Factory start
importing.

General recommendation: if you meet problems with import from an external database, launch it prior to
Mail Factory, let this application load (if any messages appear, answer them) and then start importing.
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Importing Custom Fields from Microsoft Entourage

Mail Factory cannot import custom fields from Entourage directly. This can be done via an intermediate text
file.

Export contacts from Entourage to a tab-delimited text file.

Then import the text file via the Contacts window into Mail Factory.
In the "Map To" dialog scroll down to find "custom" fields in the "File Header" column.
Click on the corresponding cell in the "Map To" column and choose a Mail Factory field to show imported
data. For instance, select "Custom1" for "Custom 1".

You should link all custom links you plan to use in Mail Factory.

Problem with Import from Microsoft Excel
(nothing was imported)

When you start importing data from Excel, it launches, opens your database, sends data to Mail Factory and
quits.

If you edited your Excel document before you start import and it stays open and not saved, Excel will show
the following message window:

If you click No, importing will be impossible because Excel won't open file from disk requested by Mail
Factory.
If you click Yes, Mail Factory will import data from file but you will loose unsaved changes.

So, don't leave the document unsaved if you are going to import data from it.

How to Create Back-Up from Embedded Databases?

Mail Factory saves embedded databases into its preferences file com.belightsoft.mailfactory.plist. This file
can be found in the following folder: ~(User Home)/Library/Preferences/

Place a back-up copy of the preferences file in other folder or (what is better) copy it to a removable storage
like CD-R, ZIP or other.

You can compress this file using one of archivers to make it smaller.
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Importing data from DayLite

Mail Factory does not support import from DayLite. You need to use intermediate data storage.

DayLite can export contact data to vCard file and tab-delimited text file. Mail Factory can import from them.

To export contact data from the DayLite application:
1. Open your list of contacts.

2. Highlight one or several contacts whose data you want to use in Mail Factory.

3. Go to the menu File/Export and choose one of possible variants:
• Export Visible Columns and Selected Rows to File to export to tab-delimited text file.

Note: DayLite will export data only from visible columns. You need to add columns containing information you
require (for this, click on the triangle at the top-right corner of the person list). Hide other columns to avoid exporting
unnecessary information.

• Export X Contacts to vCard (where "X" is the number of highlighted contacts).

Importing from vCard file is easier because you do not have to map data to internal data fields.
vCard contains all necessary information.

Printing is too slow

Mail Factory requires more time to print one page of labels than a text editor takes for printing one page of
text.
Before you see preview, Mail Factory does pre-print data processing. Merge Printing is quite time consuming,
because every address from the print list must be processed separately.

What can cause slow printing? What to do?
Setting options from the Rules section of the print
dialog.
The more options enabled, the more time is needed.

Uncheck all you do not need.
To speed up printing try to leave only "Address
Autoresize" enabled.
You can change the default state of print options on
the Printing tab of the program Preferences (Cmd+,).

Great number of contacts in the print list (during
Merge printing).

If you are not sure the program works well, try to
print 10-30 labels. This usually takes up to several
minutes (depends on the computer's performance).

Using a lot of graphics in your document. Minimize number and size of images.
Using other programs on your computer that actively
use memory and processor (music and movie
players, image and text editors when a large
document is open).

Avoid using such programs at the same time.


